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BEFORE YOU BEGIN...
A NOTE ABOUT PRE-PRODUCTION AND PRODUCTION DECISIONS

You’ve heard it before — “The most important phase of production is PRE-
PRODUCTION!” The decisions you make in Pre-Production and Production will have a
significant impact on your Post-Production activities, decisions, and workflow. This
guide is written primarily for Post-Production, but some pre- and production
considerations must be made before entering post-production phase.

This guide is intended for students in TV-2 and TV-Doc who will be editing with Avid
Media Composer, but anyone interested in editing may find it useful.

HARD DRIVES & OPERATING SYSTEMS

You will need your own external hard drive for saving your work. Depending on your
class and project, you may also need to provide a backup hard drive.

» IMPORTANT! If you do not back up your work on your own
hard drive, you will be unable to recover lost files in the event
of a system failure or primary editing hard drive failure. Your
project/media may be unrecoverable unless you maintain your
own backup copies. It is your responsibility to maintain your
backup copies on your own personal hard drive, separate from
the primary editing hard drive.

The physical type of drive you choose is important. When dealing with large HD files,
you need a drive that is fast enough and powerful enough to play back these files in
real-time. When choosing an external hard disk drive, you want it to have a speed of
7200 rpm and have its own power supply — not draw power from its USB connector.
“Passport” and “slim” drives are not a good choice for your editing drive as they are
powered from the USB (thus reducing the maximum amount of data transfer) and only
run at 5400rpm. These are good for file backups only, as they are not fast enough to
give you smooth HD file playback in real-time. For maximum compatibility, it is
recommended that you use a drive that can connect to a USB 2.0 or Thunderbolt port
(Mac only). If you use a Thunderbolt port, you do not need a separate power supply.
Beyond that, the maximum capacity is up to you and your budget — but at least 1TB is
recommended.

<
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Depending on how and where you work, you may have the option to work on a
PC/Windows or Mac/OSX system in post-production. Starting in Fall 2014, all the video
editing labs for the TV2 and TVDoc courses are Macintosh OSX systems — but there
are still some Windows PC systems in labs in the building. You may have a hard drive
that is formatted for use on only one, or perhaps both of those systems. Many students
ask why they can’t use a Mac-formatted drive on their PC, and vice-versa... and why
USB drives and flash media cards can be read and saved to on both Mac and PC.

Operating systems need to read and write files in certain ways — just like you read this
sentence in English, someone who can’t read English can read it in Japanese (if written
that way, of course) and still understand the content. Some formats can be read by
multiple operating systems, and some can be read by only a few.

Drive Format Windows OSX File Size Notes
& Operation PC Mac Limit
Windows (NTFS)
Read from drive YES YES _16 i
Wind (NTFS) (Windows 7
indows . " . o ord
Write to drive YES NO and above) possible with 3" -party software
OSX (HFS) N N . i ord
Read from drive NO YES 16 TB possible with 3" -party software
0SX (HFS) (OSXv10.3
* and above * i ith 3"-
Write to drive NO YES ) possible with 3"-party software
Dual Most USB thumb drives, flash
(FAT32) YES YES 4GB drives and cards are formatted
Read & Write FAT32
Dual Not as safe as other formats,
(exFAT) YES YES 16 EB lower fault tolerance, more
Read & Write difficult to recover corrupt data

You can see that if you have a Windows PC, you would not be able to use a Mac-
formatted drive. If you have a Mac running OSX, you would be able to read from a
Windows-formatted drive, but not write/save to it. Anything formatted in the FAT32
mode can be read by and written to using any system, but single files cannot be larger
than 4GB. For example, if you have an empty 16GB thumb drive formatted at FAT32
(usually most are by default) and try to save a 5GB file to it, an error will result,
indicating that you do not have enough disk space. The issue is that FAT32 only allows
4GB size “containers” within the total drive size — and 5GB is too big for any one
container, so that file can’t fit on that drive. Similarly, with all CF/SD cards formatted
with FAT32 by default, they can be read by any computer operating system, but a single
file can be no larger than 4GB. This presents a problem if you are recording for long
periods of time, which generate “spanned clips” — one recording spread over multiple
files. Spanned clips are discussed later in this guide.
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The exFAT format is a newer format that, when you examine the specifications, looks
like the best option out there in that it can be used almost without limit on both Mac and
PC systems. However, due to a major difference in the way the data is written to the
drive so it can be read by and written to from any operating system, the risk of losing
data or data becoming corrupt and inaccessible is greater. exFAT drives are great for
temporary storage and projects currently being worked on, moving files from one
system to another, and the in-a-pinch extra drive space for any platform. However, they
are not recommended for long-term use and storage. Using it for a semester or two is
fine, but not good if you hope to save the files for years.

In all cases, formatting a drive to the format best utilized by the operating system of the
computer you are going to use for editing is the best option. If you are getting a new
drive and know you’ll only be working on a PC, go with NTFS. If you are getting a new
drive and know you’ll only be working on a Mac, go with HFS.

Have a drive already, and it’s not in the format you need? Re-formatting a drive to a
different format will erase all contents of the drive. It is possible to create individual
partitions, or “virtual” drives within one physical drive, and have each partition formatted
differently. Formatting drives can be done on any system. If you know you will be
working primarily on one platform, use a drive properly formatted for that specific
platform. If not, you've got some decisions to make.

In the event that you do not have your own external hard drive for the first week of class
or labs, and there is no external hard drive connected to the computer you are using,
you can use a folder on the main internal Macintosh HD to temporarily save files outside
of the Avid application. In Finder, navigate to Macintosh HD - Users = Shared =2
RTFUSERSHARE and create a subfolder that is the same as your name or group
name. Anyone using the computer will have access to this folder, so do not store
sensitive documents here. This folder is “local”’ to the system on which it resides, so in
other words, it is not shared between computer systems... but any user logging in to the
local computer can access it. Treat it as a temporary saving location, or as a place
where you can leave files for other group members to access when they log in later.

» IMPORTANT! Having your own external hard drive is critical to
your success as an editor. If you save to a local machine hard
drive, you can only use that specific machine to edit your
project. So if someone else has signed up for time on that
computer, even if every other computer in the lab is available,
you can’t complete your work if it’'s saved on that one
computer. Also, if the computer hard drive crashes or the
system becomes unusable, your files are inaccessible! Bottom
line, have your own external hard drive and keep your files
mobile!
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ORGANIZING FOLDERS AND FILES USING NAMING CONVENTIONS

Once you have set up your hard drive(s), you need to set up a folder structure and
establish some naming conventions for files you will create and save. This should be
determined in consultation with the members of your production group, if you are
working in a group. In post-production, organization is paramount. If you take time at
the onset of a post-production project to create a solid organizational scheme, you
should be able to find media faster and work more efficiently when editing.

You should establish a folder hierarchy for each Sl Master Project Folder (Root folder)
project that you work on so that every file can be 2l Project Files
saved in an appropriate and easy-to-find location. B Video

To the right is a great example of a folder structure Wi Photos

for video editing. You might want to have additional s Audio

folders for scripts, transcripts, logs, graphics, effect s Sound Effects
compositions, still images, or any other category of wal Narration
files. You don’t have to make the entire folder s Music
structure at the onset of your project, but be sure to Wil Deliverables
make a folder for each maijor piece before putting M. DVD

all files in one huge unorganized folder. . Web

There are numerous examples of file and folder naming conventions in textbooks and
online, but no matter which method you use, try to adhere to these guidelines to ensure
compatibility across different software and hardware:

o Limit your file and folder names to 32 characters or less — use shorthand and
abbreviations when possible.

o Limit the number of subfolders between the root of the drive and your media files
media files. Some editing software is limited by how far into folders and
subfolders it can look for media files. Combine information in one folder name to
limit the number of unique subfolders you'll need to stay organized.

o Using a blank space is okay, but using the underscore symbol ( _ ) is better.

o Never use punctuation marks in a file or folder name, other than a period to
designate the file extension (i.e., .mov)

You can use — and + in a file or folder name, but avoid using any other symbols.
Never use a single numerical digit — instead of “2” use 02 or 002.

o When using dates or times in a file or folder name, use two digits for the day and
month, and four for the year — and figure out if you’ll use MM/DD/YYYY or
YYYY/MM/DD or something else! Military time is better than 12-hour clock time,
unless you want to add A(M) or P(M) too.
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MEDIA TECHNICAL FORMATS

You need to determine the format of footage that you will be working with in post. There
are several types of media that you may encounter, and each has its own format and
considerations. Sometimes you will be told the format of footage you’ll be working with;
other times you will have to find out for yourself. You may even work on a project that
has some footage in one format and some footage in another. Your life in post
production will be significantly easier if all of your media is of the same format, and you
know that format before you create a new editing project. But this isn’t always possible.
There are several media formats you may encounter in TV production at Rowan, and
the most common ones are indicated in the chart below.

Recording Physical . Resolution /
Device Media Codec Standard | Aspect Ratio Scan Rate & Mode
Panasonic 4:3,4:3 . .
DVX100A letterbox 480/24p*,pA 480/60i
MiniDV 4:3,4:3
Panasonic tape NTSC DV letterbox, 16:9 480/24p*,pA
DVX100BP 25 anamorphic / 480/30p*, 480/60i
sD squeeze
Studi c
ProdllJJctIic())ns ana:n6<;?phic 480/601
DVCPro
Panasonic tape IZ\IJSNCTQX 4:3,16:9 480/24p*,pA
SDX900 DV 50 anamorphic 480/30p*, 480/60i
. AVCHD 720/60p, 720/30p**, 720/24p,
P:,\’}I%ng(')c SD(/: ZZHC AVC/H.264 HD 16:9 1080/60i, 1080/30p*,
(.mts file) 1080/24p,
MPEG-4 SD 4:3 480/60p
Canon 7D CF card AVC/H.264
(.mov file) HD 16:9 720/60p, 1080/24p, 1080/30p
480/50p, 480/60p, 480/100p,
480/120p, 720/25p, 720/30p.
) 720/50p, 720/60p, 720/100p,
GoPro MicrosD | MPEG-4 o 720/120p, 960/25p***,
Hero3+ H.264 SD, HD 4:3, 16:9 rx rxn
Silver card (.mp4 file) 960/30p***, 960/50p***,
’ 960/60p***, 1080/25p,
1080/30p, 1080/50p,
1080/60p

* For these instances, progressive scan mode is used for picture imaging, but the recording uses an
interlaced mode for timecode and formatting considerations, at 60i.
** TC/format used is 60p.
*** 960 is not a standard HD resolution. GoPro 25p, 50p, and 100p frame rates are intended for shooting
in the PAL format.
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The chart on the previous page shows a mixture of interlaced (i) and progressive (p) formats. The
numbers indicate frames per second — which for NTSC-SD is typically 29.97, rounded to 30 for easier
representation. However, when you use HD formats, the listed rate depends on the scan mode. For
interlaced video, the number is the field rate. So for 1080/60i, the rate is 29.97 fps. You are seeing 60
fields in interlaced scan mode. Recall that 2 fields = 1 frame, so this gets you the 29.97 frames-per-
second rate. When you use progressive video, the listed number is the actual frame rate (since in
progressive video there are no fields). This means that for 720/60p you will have 60 frames generated in
a progressive scan rate — double the rate of interlaced — and this equates to 59.94 frames per second in
technical terminology. Yes, this can be confusing, and even professionals get confused — do a Google
search for “29.97 vs 59.94” and see what you find!

When you are ready to begin production, you will need to make sure your camera is set
to the intended shooting mode. For most typical TV projects, we recommend that you
shoot in 720/60p and use the editing frame rate of 59.94. This mode has been tested to
work well with our current editing systems, in consideration of media file size, computer
processor speeds and available memory. You can choose to shoot in another format,
or may be instructed to shoot in or edit prerecorded footage in another format.

CHECKING YOUR MEDIA TECHNICAL FORMAT

If you have already shot your footage, or are given footage to use for which you don’t
know the format, you can check to see what format was used to shoot before you set up
an editing project with the matching specifications.

Depending on the camera used to shoot the footage, and the codec being used, you
may have difficulty at first in just finding the files to play. For instance, when using the
HMC150, there is a specific folder structure that should remain intact within the main
folder called “private.” Additionally, the OSX operating system tends to disguise some
folders that contain playable media as QuickTime playable files, even though they are
actually folders. The typical card structure should look like this:

] PRIVATE » o AVCHD » g BDMV » | | STREAM

See the QuickTime logos for items named AVCHD and BDMV? When browsing in a
Finder window, if you double click on these icons, QuickTime Player will launch and
attempt to play the files, with limited success. Instead of double-clicking on AVCHD,
right-click on it once and choose “Show Package Contents” to open it as a folder. Then,
do the same for BDMV, and the STREAM folder will appear, which contains your
playable files.
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If you are working with a .mts file, open and play the file using VLC Media Player.

Media Information

Once it Isdplalylntg:‘laoc:(') tref Wln(::.OW ) |'_ General _ Statistics _'|
menu and select “Media Information...
Look specifically at Resolution for the Type Video

. . . . ) Original ID 4113
vertical frame size (in this example, it's e H264 - MPEG—4 AVC (part 10) (h264)
720) and the Frame rate. VLC Resolution 1280x720
. . Frame rate 119.880120
incorrectly multiplies the frame rate by 2 Decoded format Planar 4:2:0 YUV
when reading .mts files*, so divide by 2 stream 1 .

’ Type Audio
and you have the actual frame rate (in Original ID 4352
. . Codec AS52 Audio (aka AC3) (a52)

this case, it would be 59.94 and not Channels .
119.88, which doesn’t exist!). Therefore Sample rate 48000 Hz

. . Bitrate 384 kb/s
in the example to the right, the footage

format is 720/60p. *using VLC version 2.0.3.

If you are working with a .mov file,

) X MVI_3637 MOV — Inspector
you can open and play the file using
VLC Media Player or QuickTime MVI_3637.MOV
Player. Once it is playing using
. . h s /Volumes/TVRUGGEDD 1/ AMA TESTING/
QuickTime Player, go to the Window 60D/MVI_3637.MOV
menu and select “Show Movie : H.264, 1280 x 720
” . : : Linear PCM, 16 bit little-endian signed
Inspector” and you will see information integer, 48000 Hz, Stereo (L R)
similar to what is pictured to the right. FPS: 59.04
For .mov files, FPS does indicate Data Size: 84.3 MB
frames per second, so in this example, Data Rate: 47.56 Mbit/s
we again have footage shot at Current Size: 1280 x 720 (Actual)
720/60p.

Working with a .mp4 file? Either VLC or QuickTime should be fine, but depending on
the codec used, VLC may be your best bet. Both will show the accurate frame rate.

It is very important to determine the format of footage you will work with BEFORE you
create a new project, especially when using Avid Media Composer. Choosing project
settings that are different from your footage format will force the program to reprocess
your footage to the format you choose (taking additional time to import or render), rather
than leave it in its original format. Exceptions to this rule are possible, if you know you
will be outputting in a certain format and need everything to conform to that format. But
usually, choosing to create a new project with the same specifications as your source
footage is the best approach. Yet no matter what type of footage you are working with,
you will want to back it up before editing.
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SAVING, TRANSFERRING & BACKING UP YOUR RAW FOOTAGE

Hard drives crash. Files are corrupted. People make mistakes. Your digital media
could be lost at any time. We can all do our best to maintain computer systems and
keep them in a healthy status, but every once in a while something bad can happen. In
that event, it's good to have a backup copy of everything, just in case. YOU and YOU
ALONE are responsible for backing up your projects, media, and supporting files. After
production wraps for the day, many students want to rush right into editing — fight the
urge and spend time now to save time and frustration later! Later in this guide you will
learn how to backup ALL of your project materials — for now, we’ll focus on the raw
footage.

For physical tape, you should immediately put the
REC/SAVE tab on the tape spine to the SAVE position
and store the tape in a relatively cool, dry environment
— the backseat of your car doesn’t qualify. Since you
will eventually be working with a digital ingest version of
the footage, you needn’t duplicate the entire tape. If
something should happen to the digital ingest version, you can always re-ingest the
media from the original tape. So keep the tape in a safe place at all times!

For tapeless media recorded on CF and SD cards, the procedure is a
bit more involved. First, it's a good idea to move the tab on the card  walp
to the LOCK or SAVE position, just as you would on a tape, to i
prevent accidental erasure — that’s the easy part. Do this as soon as
you remove the card from the camera, so that at a glance you can see ]

which cards have already been used.

Next, you need to determine where you will save/use the footage for editing, and where
you will save your backup copy — essentially, you need two separate hard drives.
Depending on how your class or project is set up, you may or may not be provided a
hard drive for primary editing. When in doubt, have your own ready to go. You can also
use your personal computer hard drive as a backup location, though that isn’t as good
as a dedicated external hard drive. Keep in mind the format of the hard drive and the
type of computer system you are using. Since your raw footage is shot on cards in the
FAT32 file format, your backup/archive drive for raw footage could also be FAT32 — and
then it doesn’t matter what platform you use to offload/backup the footage. However,
since rendering and output files could likely be larger than 4GB, you probably do not
want to use the FAT32 format for your main editing drive.

Once you have identified your edit drive and your backup drive, first connect your
backup drive to the computer. If you've already set up a folder structure and naming
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conventions (as described in the previous section), use what you've already created. If
you are starting from scratch, then take this time to create a new folder for the footage
you’ll be backing up for a particular project. Name the folder and include something
appropriate like “rawbackup” in the title.

Next you'll create a subfolder for each SD or CF card you used. If you haven'’t already,
now is the time to develop a naming convention to keep things organized. You could
simply say Card01, Card02, etc., or better, include the date the card was shot, as in the
example to the right. Always use double (or even triple) digits when numbering folders
for cards. There are many other pieces of information you may want to include in the
name of the folder, such as location or subject. To minimize the number of subfolders,
it's better to include as much of this information as EOLIRMAL
possible within the first folder name. Whatever you
do, create a solid naming convention rule that you or v [ PostGuide_rawbackup
your group members establish for the project, and » [] 09-15-2014_01
stick to it!

Name

Once you have your backup drive folder structure ready to go, connect the SD or CF
card to the computer using a USB card reader. Copy the ENTIRE card contents,
including all subfolders and files, to the folder you created on your backup hard drive for
your first card. When the copy is complete, eject/disconnect your backup drive and
connect your editing drive, and repeat the entire process. Though it may be faster to
copy from drive to drive, it is always safer to copy from card to drive so if there was a
flaw on the first copy procedure, you are not duplicating the flaw. Also, it is highly
recommended that you keep the drive/folder/file structure and naming conventions
identical, as then it will be easier to restore your project from the backup drive if needed.

» IMPORTANT! DO NOT change the file names or contents of
any folders on the SD or CF card. The folder structure and file
names on your backup drive should be identical to the folder
structure and file names on your primary editing drive.
When you import/link media in your editing application, you will be
able to rename the media (or actually, the reference link to the
media) without actually renaming the files.

wp  Erireme Pro]

Repeat the process for each card used, making a new folder for each

individual card. Once a card has been copied to both your editing drive B
and your backup drive, change the card tab to the UNLOCK position so it is
ready for re-use.

After you have backed up all of your raw footage, disconnect your backup drive and
shelve it in a safe place! Don’t carry it around in your backpack all day, and try not to
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use it for other purposes. This is your safety net in case your primary editing drive fails
or has any problem that would make your files inaccessible! Plenty of projects —
student and professional — have been lost or ruined due to failed hard drives, but many
have been saved and rebuilt successfully with the help of a well-maintained and
updated backup drive. Just as you are now backing up your raw footage, you will want
to back up your project files, scripts, logs, graphics, and any other files you create for
your project — often it's as simple as copy & paste! Just remember to disconnect your
backup drive before you begin editing, so that you don’t confuse yourself (or the editing
program) as to which drive you’re using when you import and edit your footage.

Once you have successfully copied the files from the SD or CF card(s), eject/remove
the card(s) and card reader so that only your editing hard drive is connected to the
computer. Never import directly from the card! With only your editing drive connected
to the computer, you are ready to begin editing. While you may choose to use other
software, the remainder of this guide pertains to specifically to Avid Media Composer
non-linear editing software. Continue to the next page to begin working with your
footage in Avid Media Composer.
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GETTING STARTED WITH AVID MEDIA COMPOSER AT ROWAN UNIVERSITY

It has been determined that the Avid systems crash less, function better, and give YOU
fewer headaches only if you...

RESTART THE COMPUTER BEFORE LOGGING IN!

A full reboot may take a few minutes, but it's worth it! If you ever encounter a system

flaw or error message, you’ll want to do some basic troubleshooting and trial & error to
fix the problem. But if you can’t resolve it, try restarting the program you are using. If

that doesn’t work, reboot the whole computer. If you still have problems, seek help!

SYSTEMS & LOGINS

Bozorth Lab 154 has six iMac workstations and Lab 146 has three iMac workstations.
Log in using your Rowan network username and password.

Wait for all of the startup procedures to complete (about 1 minute) after logging in
before you begin working. Your H drive will mount on the desktop and the background
image may change or flicker as tasks load and complete.

LAUNCHING AVID MEDIA COMPOSER

Single-click on the icon for “Avid Media Composer” in the dock. If you cannot

find it, open a Finder window and open it from Applications - Avid Media
Be—a Composer. Wait about 2 minutes — this is a big program and takes a while to
start up. Please be patient. The screen may flicker, go black, or seem to freeze

momentarily — this is normal. Note: The Avid software will encounter performance
issues if other processor- and RAM-intensive programs are running simultaneously.

CREATING \ SAVING \ MOVING \ OPENING YOUR AVID PROJECT FILE

If you haven’t already done so, you will create an Avid Project File for your work. Even
though Avid refers to it as a file, this is really a folder containing all the information
necessary to assemble your project — essentially, the blueprints. The project file
contains bins, sequences, and media information — but not the actual media files. The
Avid software will create everything for you as you go, and all you will need to know is
the save location of the project file.

At the top of the next page is an example of some files and folders contained in a typical
Avid project file. The project is called PostGuide Demo and the file includes the folder
named the same, and all of its contents. The file and folder names within your own
project file may vary. “Audio”, “Sequences” and “Video” are file folders that represent
user-created folders within the project. You should not manally create anything here.

TV Post-Production Guide ~ September 2014 Page 14



[ PostGuide Demo

£\ common 2 » [ Applications L (L atadmin " [ Adobe " [] AMA Management L (L] PostGuide Demo * [ Audio 3
1] DOCDRIVED4 £ = [@ Library [ frandino r [l Avid ’ [ Avid Attic ’ =] PostGuide Demo Settings.avs
£ FOURFAT & » @ opt [ Guest =[] AvidBinindexer L (L] Avid FatalErrorReports " PostGuide Demo Settings.xml
£ FOURMAC & » [ System [ nssadmin +  [] AvidMediaComposer ’ [ Avid SearchData ’ B PostGuide Demo.avp

[T} Home A+ (&) Users » [ profile » [] AVX Plug-Ins Data * [ Avid Users » [ SearchData >
|=! Macintosh HD 3 (3 radino = [ Citrix " [ Background 3 (1] Sequences 3
@ Network » (] Shared *  [] TranscodeServiceWorker =[] DSMLogFiles b (] Staristics »
7] TVRUGGEDO1 s &% winkler " [ MarqueeTitles » [ Video -
[ winkler Bl (] Shared Avid Projects (1] WaveformCache "

[ Synced Avid Projects  F
Il i i 1 Il Il Il

The software will function better if your project file is on a separate drive from your
media files. Keeping the project and media files on separate physical drives while you
are working will increase system performance and speed. Then when you are done
working, you can move your project file to your own drive for safekeeping. When you
are ready to work again, copy the project file from your drive to the system drive, and
then copy it back when you are done. Since the project file is relatively small, it's a good
idea to keep a few versions readily available — an easy way to make backups! More
about this in a bit...

When you launch the Avid software, you will see a project and user profile selection
dialog box with some save location options for the project.

¢ Private — this will use the current
logged in user’'s Documents \ Avid
Projects folder. You cannot change
this location path.

e Shared — this will use a folder on the
local system that is accessible by all
users. You cannot change this location
path.

e External — this will use any folder
location you specify. You can set this
location by clicking on the open folder
icon at the top of the dialog box, and
the chosen path will be indicated in the
“Folder” line beside it.

If no project files can be found, the selection box will be blank. The User Profile should
be the same as the username you used to log into the computer.

To create a new project, first choose where you want to save the project — private,
shared, or external. Ordinarily, if you are working on an individual project that only you
should have access to, you would choose the Private option. As of this writing, projects
saved in the Private area save to the individual logged-in user’'s Documents folder on
the local computer. However, as Rowan systems and accounts are updated, this folder
may eventually exist on the user’s H drive. If you open and try to use your project file
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from your H drive, you may experience performance issues, program hang-ups, and
other adverse issues as network speed and traffic volume is unpredictable.

The safer and more stable method is to create/open and save your project in the
Shared location. This is a location on the local computer and not the network. Using
this location, your project file will exist on the local system hard drive while you are
working (and then when you close your Avid session, you can move the project file to
your own hard drive for safekeeping). Although while in the Shared location, your
project is accessible by anyone using the computer, it is a guaranteed “local” save
location. You can always copy your project file to your Documents and/or H drive
folder, and delete the version on the Shared location if you do not want anyone to see
your work. But never open or actively work on a project saved in a network folder
location! You can move it back to the Shared location before working on it again - more
on that in a bit.

After selecting Shared, click the New Project button.

Now, provide a logical NAME for the
project! If working in TV2, you
probably want to use the naming
convention
TV2_ProjectName_YourLastName,
or whatever your Professor instructs
you to do! DO NOT leave the default
name as New Project. Even if you're
just playing around and trying this
out for the first time, provide a
legitimate name for the project like
YourName_Test.

In a previous section of this guide,
you learned that you need to
determine the format of the footage
you will be working with so that you can set the Avid Project format setting to the same
format. Once you set the project format, it is difficult to change to another format,
especially if the timecode base is different or you want to switch from a progressive to
an interlaced format, or vice-versa. Always verify what your primary footage format
will be, and in most cases, set your new project format to that.

For most typical TV projects, we recommend that you shoot in 720/60p which uses the
timecode base frame rate of 59.94 — so if you’ve shot with this recommendation, set
your project to 720p/59.94 as in the above pictured example. Also make sure that the
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“‘Raster Dimension” is set to the actual frame size (in this case, 1280x720) and
“Stereoscopic” is Off. Color Space and Aspect Ratio will be locked, and do not check
the “Matchback” option. If you choose to work in another format, you’ll want to
experiment with the footage you’ve shot to see the best look, and possibly do some trial
and error to see which project format will be best.

The most often used formats include 720/60p @ 59.94 fps, 720/24p @ 23.976 fps,
1080/24p @ 23.976 fps, and 1080/60i @ 29.97 fps. Even if you are shooting 24p, do
not select exactly 24 fps — this is for export and formatting back to film that runs at a true
24 fps. If you are going to a digital file format for playback on DVD, BD, or the web,
choose 23.976 fps instead of 24 fps whenever setting up a 24p project.

Note that once you set the name of the project in this step, you cannot change the
project name while working in the Avid software. Choose wisely and check for typos!
When you are ready to create this project file, click OK, and you’ll see the project file is
now listed in the Select a Project window. Choose it and click OK to open the project.

After you work on your project, save it, and close Avid, you will want to move your
project from the “Shared” area on the local hard disk to your own editing drive or USB
thumb drive, so that you can re-open the project on another computer and also have a
backup/safety copy. Browse to:

Macintosh HD 2 Users 2 Shared = AvidMediaComposer -2 Shared Avid Projects

Y common 25 Applications L (] atadmin L ] Adobe L ] AMA Management L (] PostCuide Demo
[ DOCDRIVED4 (@] Library L [ frandino £ Avid L [ Avid Attic L

) FOURFAT 3] opt L (] Guest L (] AvidBinindexer L (1] Avid FatalErrorReports L

) FOURMAC (3] System ] nssadmin L [ AvidMediaComposer L (] Avid SearchData

4 Home L (] Users [ [ profile L [ AvX Plug-Ins Data L Avid Users

[ L 3

[ Macintosh HD' L (21 radino L L3 Citrix L [0 Background

@ Network L (] Shared (1] TranscodeServiceWorker © (] DSMLogFiles

) TVRUGGEDO1 4% winkler L ] MarqueeTitles

Y winkler ] Shared Avid Projects
] Synced Avid Projects

[LN13

You will see a folder for your project, in addition to folders for any other project files that
may reside on that system. Copy the entire folder for your project to a folder on your
own personal hard drive — it's a good idea to place it within a new folder you create
called “My Avid Project” or something to that effect, so you don’t confuse it with anything
else related to the project. It is up to you as to whether or not you want to delete the
original project file from the original system location. You may find it advantageous to
leave it there so you'll have a backup copy in existence, just in case...or perhaps move
it to the Documents folder under your own personal log in for an additional safety net
(Macintosh HD - Users - yourname - Documents - Avid Projects).

Then, if you want to work on your project on another system, simply connect your hard
drive and copy the project file (folder) from your hard drive to the same path as before
on the new system:
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Macintosh HD 2> Users -2 Shared 2 AvidMediaComposer -2 Shared Avid Projects

Remember, to achieve the best performance and system speed, you want to have the
working copy of your project file on a different non-network drive than all of your media
(which we have yet to specify how to save — read on to find out more!). If your project
file (folder) exists in the above system drive path, it will appear in the Shared list in the
project selection dialog box.

» IMPORTANT! DO NOT change the contents of the Avid
Projects folder while the Avid software is running. ALWAYS
QUIT THE AVID SOFTWARE before moving/copying/pasting
contents of the Avid Projects folder.

As you progress through your project, you may move to and from systems quite
frequently, and make major changes to your project. You may want to consider keeping
multiple versions of your project file (folder) on your personal hard drive. An easy way
to do this is to create a folder on your hard drive called “My Avid Project”, then a
separate subfolder for each version — you could use a naming convention that
expresses the date/time a version was saved, or use a version number. Then when you
are ready to edit, copy/paste the most recent version (or any version you want to work
with) to the editing system. That way, if there is an error during copy/paste, at least you
will have an alternate/older version of your file you can work with, rather than nothing at
all!

THE AVID PROJECT WINDOW
'x[[=[+[ PesiGuideDemo-winker | When you create and open a new project,

the Avid project window opens and the
| = [nie| first bin is created for you, named the

| same as the project plus the word “Bin.”

™ PostCuide Demo Bin 4K You should rename this bin to something
useful, and also add additional bins and
organizational folders, much in the same

4] O way you set up a folder hierarchy on your
backup and primary editing hard drives. Note that you can put folders inside other
folders, and bins inside of folders, but you cannot put bins inside of other bins or folders
inside of bins. Also note that the window name lists the name of the project and the
loaded user profile.

The project window controls all aspects of the Project File and also the settings for the
project and system. When saving your project (and it's a good idea to save often),
simply click on the project window and hit 8-S (or Ctrl-S on a PC) to save everything in
the project at once.
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Additional functions and features of the project window include a settings list (detailed in
the next section of this guide), effects, project format, project usage statistics and
system info. If you click the X in the upper right corner of the window, this will save and
close your entire project and bring you back to the project selection dialog box.
Operations and functions of the project window are detailed extensively in online
tutorials and software documentation, and will not be detailed here.

AVID SETTINGS TO CHECK IMMEDIATELY

Most program and system-specific settings
should be preset for you if you are using a
Rowan Avid system. Note that these
settings are not necessarily the default
software settings, but rather the settings we
have preset for you to use in the Rowan
labs. However, some settings are project-
specific and must be verified after creating a
new project or even opening an existing
project.

Locate the project window and click the
“Settings” tab.

Scroll down the list until you find the entry
for Media Creation. Double click this item, and a new dialog box will appear.

On the “Drive Filtering &
Indexing” tab, make sure all
three filtering options are
checked. This will ensure that
your media files are imported
and saved to your externally
connected hard drive and not
your H drive or the system hard
drive. If you have no external
drive and want to save (temporarily) to the internal system hard drive, uncheck “Filter
Out System Drive” and uncheck “Filter Out Launch Drive.” However, this is not
recommended as it is best that you use your own external hard drive.

The subsequent tabs are used to determine the compression format and save location
for all of your captured, imported, rendered, and otherwise internally created media files.
If you are working in an SD project, choose DV 25 411 MXF for capture and all other
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tabs. If you are working in an HD project, choose the midrange DNxHD MXF option.
The best choices for the most common formats are:

Format Recommended _
DNxHD MXF Resolution
720/24p DNxHD 60 MXF
720/60p DNxHD 145 MXF
1080/24p DNxHD 115 MXF
1080/60i DNxHD 145 MXF

Next, you need to specify the hard drive onto which the
media files will be saved. Be sure to choose YOUR
primary editing drive which should show up in the
drop-down list. The hard drive with the largest amount
of free space is detected by default and indicated in
bold in the drop-down selection list. Again, make sure
you select YOUR drive at this point and click every “Apply to All” button that you see.
Then choose each subsequent tab, and make sure that the drive selected is the correct
one. All tab options should have the same drive selected. Then click “OK.”

» IMPORTANT! If you do not verify that the Media Creation
settings for your project will save media to YOUR hard drive,
your media might be saved to a drive physically contained in
the local computer system you are working on. This means
that when you try to open your project on another computer, all
the media will be offline because it did not travel on your hard
drive to a different computer. Save time and frustration later by
checking these settings NOW! And re-check these settings
EVERY TIME you open your project.

When you choose a drive in the Media Creation settings, Avid will create a system
folder on that hard drive called Avid MediaFiles.
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DO NOT rename, move, erase, add anything to, or remove anything from, this new
folder. Just let it sit there untouched — Avid will manage it for you. Again, do not
directly add any files to, or remove any files from, the Avid MediaFiles folder.

Click OK in the Media Creation window and go back to the settings list in the project
window.

Double click the General setting item. The
current project format appears at the top of the
window. Depending on the format of the
project you are working on, these settings may
vary. When working with drop frame timecode
(23.976fps, 29.97fps, and 59.94fps), your I 0::00:00:00
Default Starting TC should be 00;00;00;00
(note the semicolons). When using non-drop
frame timecode (true 24fps, true 30fps), you
should see 00:00:00:00 (note the colons). The
TC display format can be changed to fit your
preference — when working in 60p (59.94fps),
you will want to see timecode represented at
60fps. Keep in mind that this only changes the
TC display and not the actual TC format. When working in SD-NTSC, use DV25 for
effect aperture. Check the NTSC Has Setup option — this ensures proper color
standards and pixel mapping for effects. Also, keep the option to Use Windows
compatible file names and path limits checked. This will ensure maximum cross-
platform compatibility for your projects. Then click OK on this window and go back to
the settings list in the project window.

Double click the AMA setting item. Click on the
Volume Mounting tab and make sure that
Automatically AMA-link to volumes is
checked. Then click ok to return to the settings
list.
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Next, double click the Audio setting item.
The only item in this window you need to
verify is the Default pan for mono tracks.
This sets the global audio pan settings for
your project. By default, it should be set to
Alternating L/R — this puts all your odd
numbered audio tracks panned left, and all
even numbered audio tracks panned right.
This helps to identify individual tracks and
isolate the best quality audio, especially if
multiple inputs and microphones were used
for a recording. You can always pan your audio track-by-track later... or if you want
everything panned center by default, you can choose the All Tracks Centered option.
This can help ensure that your audio is not bouncing from left to right unintentionally,
but it is harder to identify individual audio tracks while editing.

That’s all you need to check for now, but there are numerous other settings that you
can explore and learn about which are listed for reference on the following pages.
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OTHER AVID SETTINGS

If an option is given in Avid and nothing is listed here, that option should be either off,
unchecked, or left alone. In the Project Window under the Settings tab...

AMA
Bins
The selected items should be “Create a New Bin”, “Volume Name”, and “Display
Editor headframe”
Quality
Select “Highest Quality” in all areas.
Volume Mounting
The chosen option should be “Enable AMA Volume Management”
Link Options
Multi-channel audio = None (or all set to Mono)
Alpha Channel = Invert (white = opaque)

Audio
Default Pan
1 Alternating L/R : True stereo sound or individual channels.
Odd audio tracks are left, even are right (you can pan later)
2 All Tracks Centered  Allows for a mono mix of all channels
equally to both left and right
3 Leave all other settings at their defaults.

Audio Project

Main Tab
1 Sample Rate 48 kHz
2 Audio File Format PCM (MXF)
3 Sample Bit Depth 16 bit
4 DV Audio Pattern Locked Audio
5 Convert Samples... Always
6 Show Mismatch... Yes
7 Remove Extra Filler... Remove
Input Tab
1 Input Source Host-1394
Output Tab
1 Button should read "Stereo". If it says mono, click it to change.
Effects Tab
1 Effect bypass < nothing selected >
2 Render Sample Rate... High and Slow
3 Real-Time Audio... Enabled
4 Dissolve Midpoint... Linear -6dB
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Bin

1
2
3
4
5
6
7
8
9
1

Capture

Autosave every

Inactivity period

Force Autosave

Maximum bins in a project attic
Maximum version of a bin in the attic
Double click loads in

Use Border Colors and Icons

Enable edit from bin

Always keep at least one version in attic
0 Show local media icons

General Tab

O©CONOOOAAPRLWN -~

Stop deck after capture

Pause deck after capture

Preroll Method

Force Unique Clip Names
Activate bin window after capture
Space bar stops capture
Capture across timecode breaks
Stop capture if a bad frame...
Ignore Media Read Errors

10 Capture a single video frame

11 Ask before discarding cancelled clip
12 Ask for name when new tape is seen
13 Display incoming video in the client
14 Pause deck while logging

Batch Tab

1

2
3
4
5
6
7
8
9
1

Optimize for disk space
Optimize for batch speed

Switch to emptiest drive if...
Rewind tape when finished...
Eject tape when finished...

Log errors to the console...
Capture the tracks logged...

Use the audio sample rate...

Use the audio sample bit depth...

0 Use the video compression...

Edit Tab
Do select the option listed to Enable edit to timeline

MXF Media Files

1

Maximum default capture time:
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10 minutes

45 seconds

15 minutes

1000

50

Source or Record Monitor
YES

YES

YES

NO

SELECTED
NOT selected
Best Available
YES

YES

NO

YES*

YES

YES

NO

YES

YES

NO

NO

SELECTED
NOT selected
NO

NO

NO

YES

YES

NO

NO

NO

63
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2 Do NOT select Switch to emptiest drive...

DV & HDV Options

DO NOT selected DV Scene Extraction or Enable detection...

*Capture across timecode breaks: Your footage should not have timecode breaks!

Composer
Window Tab
1 Data Display at Top
2 Button Display at Bottom
3 Center Duration
4 Tick Marks in Position Bars

Edit Tab

1 Color Framing

2 Sync Point Editing

3 Single Mark Editing

4 Phantom Marks

5 Auto-create New Tracks

6 Auto-enable Source Tracks

7 Copy Source Locators
8 Undo Only Record Events
9 Activate Record Monitor After
10 All other options checked

FF /REW Tab
1 Stop at Head Frames
2 Stop at Tail Frames
3 Stop at Locators
4 Ignore Track Selectors

MultiCam Tab
Split Mode Play
MultiCam Mode Client Monitor

Correction
Features Tab
1 Saved Color Labels
2 Eyedropper 3x3 Averaging
3 Show Eyedropper Info
4 Eyedropper Picks...

AutoCorrect Tab

Chosen option should be "Nothing"
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Always Display Two Rows of Data
Two Rows

YES

YES

OFF
NO
NO
NO
YES
YES
YES
NO
NO

YES
NO
NO
YES

Quad or Nine Split
Linecut

Name and RGB
YES
YES
YES
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Desktop Play Delay
By default, set at 0 frames. If you connect an external VTR, this may change to
maintain audio/video sync on both desktop and VTR.

Effect Editor

1 Indent Rows YES

2 Large Text NO

3 Thumbwheels NO

4 Real Time Update YES

5 Set Position to Keyframe YES

6 Update Position While Playing NO

7 Show Add Keyframe Mode Menu YES
Full Screen Playback

1 Scaling Project

2 S3D View Off

3 S3D Overlay Off

4 Target Mask No Mask

5 Full Screen YES

6 Display Both Fields YES

7 Flip On Vertical Sync NO

8 Expand Luminance For Computer YES

You can specify the monitor for full screen playback by dragging the settings window
to the monitor you want to use, and click the Select Monitor button.

General
Temporary File Dir: [do not adjust]
Default Starting TC Sets new sequence starting timecode.
Will not change existing sequence timecode.
Best to set to 00;00;00;00 (using semi-colons)
TC Display Format Depends on project frame rate. If using 60p, use 60fps.
1 Effect Aperture DV25 (720x480)
2 NTSC Has Setup YES
3 Windows comp. YES

Import

Image Tab
1 Image Size Adjustment Image sized for current format
2 File Pixel to Video Mapping Computer RGB 0-255
3 Alpha Channel Invert on import (white = opaque)

DO NOT dilate fill

4 Frame Import Duration 30 seconds
5 Autodetect Sequentially... DO NOT CHECK

OMFI/AAF Tab

Use the current import resolution
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Shot Log Tab
Maintain events as logged.

Audio Tab
1 Multichannel audio = None / all mono
2 Convert source sample rate to project sample rate on import
3 DO NOT convert sources w/ pull-up and pull-down rates
4 Convert source sample bit depth to project sample bit depth on import
5 DO NOT apply attenuation/gain on import
6 DO NOT auto-center or pan mono clips
7 DO NOT auto-detect Broadcast Wave Mono Groups

Interface
You can custom-configure the software interface brightness and color scheme.
Show Labels in Tool Palette and Show ToolTips should be checked.

Keyboard
Allows you to see all the keyboard shortcuts!
Common changes w/ command palate to create “RTF Modified Keyboard”:
Change F8 to "Red Marker", Change N to “Add Edit” ,Change Up arrow to FF,
Change Down arrow to REW, Shift+l = Clear in, Shift+O = Clear Out, Shift+M to
match frame, Shift+N to reverse match frame

Media Creation
Drive Filtering & Indexing Tab
Select all three filtering options; this will disable media saving to the local
machine hard drive.

Capture Tab (only for Standard Definition NTSC 30i projects)
1 Video Resolution: DV25 411 MXF
2 Choose the drive option () and then click Apply to All
3 All other tabs — for HD projects, use lowest number DNxHD MXF (145).
Choose your drive option () and then click Apply to All

Render Tab
Same as Source OK, Save after Render OK, Automatic Effects Processing OK
Timeline
Display Tab
1 Show Toolbar YES
2 Show Marked Region YES
3 Show Marked Waveforms NO
4 Highlight Suggested... YES
5 Show Position Bar NO
6 Show Effect Contents NO
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Use Fast Scrub

= © 00 N

Edit Tab

Auto-Patching
Auto-Monitoring

O©COoONOOOAPRWN -~

Start Filler Duration
Find Flash Frames...

Double-Click to Show Nesting
Show Four-Frame Display

0 Movement During Play

Segment Drag Sync Locks
Default Snap-To Edit
Default Sync Locks On
Dupe Detection Handles
Click the TC track...

10 Only One Segment Tool

11 Default Segment Tool

12 New Sequences

13 Lassoing transitions enters

Trim
Play Loop Tab

YES
YES
YES
NONE

00:00:05:00

5 frames

YES

NO

YES

NO

NO

0 frames

NO

NO

Segment Insert
1 Video, 2 Mono Audio Tracks
Trim Mode

Preroll 2:15, Postroll 2:15, No Intermission

Features Tab

Select "Never use Small Trim Mode"

Auto Focus when entering Trim mode

Render On-The-Fly
Dual Image Play
J-K-L Trim

Video Display

DV Output Setting (SD only)

Enable Confidence View
Highest Quality Scaling...

Output To DV Device selected for firewire output

DV 25 411

YES
YES
YES
YES

Realtime Encoding selected
(must have timeline open to change, and be
connected to IEEE 1394 firewire device)

YES
YES

Maximum Real Time Streams Stream Limit: 8
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The following User or Project settings have been reconfigured to be Site settings
(via the “Special” menu) on all RTF Avid systems:

AMA General

Audio Import

Audio Project Interface (Standard Avid Default)
Bin Keyboard (RTF Modified Keyboard)
Capture Media Creation (Full Filtering
Composer DNxHD 145)

Export (QuickTime Mov SaS) Timeline

Export (QuickTime H.264) Trim

Full Screen Playback Video Display
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RTF Modified Keyboard

Frequently used shortcuts

Q =Gotoln e Z = Lift

W = Go to Out E = %ﬁg: I(';ut X = Extract

Eorl =MarkIn G = Clear In & Out V = Splice In Edit

Ror O = Mark Out H = Focus Timeline B = Overwrite Edit

T = Mark Clip J = Play Reverse N = Add Edit (split clip)

U = Enter Trim Mode K = Pause M = Move back 10 frames
A =Go to start L = Play Forward , = Move back 1 frame

S =Gotoend . = Move forward 1 frame

Left Arrow = Go back one frame /" = Move forward 10 frames
Right Arrow = Go forward one frame

Up Arrow = Go to next edit

Down Arrow= Go to previous edit

F8 = Add red marker on selected track at this point

38 + [ and 38 + ] will expand or shrink the timeline view, horizontally
38+ K and 38 + L will expand or shrink the timeline view, vertically

Push J + Kor K + L and you can play slow-mo reverse or forward
Tap J or L multiple times and you will play faster reverse or forward

When using keyframes, you can delete a keyframe by pressing “DEL” on the keyboard
when the little hand appears on the timeline over the keyframe you want to remove

When using keyframes, you can move a keyframe left and right along the track
by holding the Alt key and then clicking

When you push SHIFT, you get a second Smart Tool shortcuts:
set of customized keyboard commands.  Shift + A is Segment Mode for Lift/Overwrite
Shift + S is Segment Mode for Extract/Splice-in

Shift + | is Clear In Shift + D is Overwrite Trim Mode
Shift + O is Clear Out Shift + F is Ripple Trim Mode
Shift + M is match frame Shift + G is Keyframe Mode
Shift + N is reverse match frame Shift + L is the Link Selection Toggle
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ADDITIONAL QUICK-REFERENCE KEYBOARD SHORTCUTS

HOT KEYS
CTRL/ ¥  and c COPY
CTRL/#  and S SAVE
CTRL/3  and =] (After clicking on on project window) SAVE PROJECT
T (After clicking on timeline) SELECT CLIP
X EXTRACT CLIP
1 STEP BACK 8 FRAMES
2 STEP FORWARD 8§ FRAMES
3 STEP BACK 1 FRAME
4 STEP FORWARD 1 FRAME (or use the back and forward arrows for one frame at a time)
6 PLAY IN'OUT MARKED CLIP
W SPLICE IN
HOME PLACES THE POSITION INDICATOR AT THE BEGINNING OF THE SEQUENCE
END PLACES THE PLAYHEAD AT THE END OF THE SEQUENCE
SPACE PLAY/STOP CLIP
U ENTER TRIM MODE

CTRL and _LEFT-CLICK [SNAP TO THE END OF A SELECTED CLIP/EDIT POINT

CTEL and MOUSE DRAG|(In Extract / Overwnte Modes) —SNAP TO THE EDIT POINT

CTRL and MOUSE DRAG|[After setting clip IN point) SNAP TO EDIT POINT IN LIFT OVERWRITE SEGMENT MODE
ALT/OPT  and - DRAG A MARKED SUBCLIP INTO ABIN

CTREL/#  and A ADD VIDEQ TRACK
CTRL/ ¥  and U ADD AUDIO TRACK
u ENTER/EXIT TRIM MODE
(or to enter trim mode, lasso around the edit points)
(or to exit trim mode, click on the time-code track)
SHIFT and F ENABLE / DISABLE RIPPLE TRIM MODE (yellow button)
SHIFT and D ENABLE / DISABLE SHIFT OVERWRITE MODE (red button)
J REVERSE PLAYBACK IN REAL-TIME (PRESS TWICE FOR DOUBLE-SPEED)
K PAUSE
L PLAYBACK IN REAL-TIME (PRESS TWICE FOR DOUBLE-SPEED)
J and L FORWARD PLAYBACK AT 1/4 SPEED
K and J REVERSE PLAYBACK AT 1/4 SPEED
ADDITIONAL
YELLOW ARROWS SPLICE IN / EXTRACT RELATED
RED ARROWS OVERWRITE / LIFT RELATED

ENABLE BOTH ARROWS — TOP HALF OF CLIP WILL BE LIFT/OVERWRITE; BOTTOM HALF WILL BE EXTRACT/SPLICE
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CUSTOMIZING YOUR OWN AVID USER PROFILE \ USER SETTINGS

As an editor, you may want to change properties of Avid settings to fit your comfort and
ease of use with the software — the most commonly customized setting is for keyboard
shortcuts. Avid gives you the option to save your own user profile on each system you
use, and take your own personal settings with you as you move from system to system.
As you gain proficiency and comfort with the editing application, you may want to take
advantage of this feature.

To begin, go to the project window and click on the
Settings tab. Just below the tab line but above the
settings list is a drop-down menu that lists the
currently loaded user profile and user settings,
which by default should be the same as your Rowan
systems username. You can continue to use these
settings and update them as you wish. Alternatively,
you can create separate user profiles or different
settings depending on the tasks you need to perform
within the application.

If you want to create a new user profile, click the drop-down menu and choose the
option to Create User Profile. In the resulting box, name the profile you want to create
— usually, this will be your name, but could be anything. Then click OK.

The profile is reloaded and you can see that your new profile name is listed in the drop-
down menu where your login username used to be. You can now change settings as
you like without affecting the original profile. Also, if you are opening or creating a new
project, you can now select any of your named profiles at the project selection screen
when the Avid software first launches. Note that the newly created user profile settings
are the same as the default settings created by the Avid software. Any settings you
previously adjusted under the profile automatically loaded with your username are reset
under the new profile.

Your user profile will exist only on the original system you created it, unless you choose
to export it and take it to another system. To do this, use the same drop-down menu
and choose Export User or User Profile. You'll then choose where to save the file —
preferably on your primary editing drive or your own USB thumb drive. Then, when you
move to a new system, you can go through the same steps and instead of creating or
exporting, you’ll choose the option to Import User or User Profile. Anytime you make
changes to your profile or settings, it's a good idea to re-export, as they are not
automatically saved back to the location you import them from.
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In the event of a problem, such as your user profile becoming corrupted or unable to
open, you can download and re-install the original profile settings from the TV
Production Resources website.

» IMPORTANT! DO NOT change the contents of the Avid Users
folder within the system drive while the Avid software is
running. ALWAYS QUIT THE AVID SOFTWARE before
moving/copying/pasting contents in the system Avid Users
folder.

Each individual user profile is created within the master user folder.

Macintosh HD 2 Users - Shared =2 AvidMediaComposer 2 Avid Users = [name]

= Applications * [ atadmin [ AMA M. [ AvidWebCach & MCstate
£ = (@ Library * [ frandina [ Avid At [ franding |=] MyCustomSettings Settings.avs
B 3 opt L [ Guest £ Avi « mcbg.pct " MyCuste ngs
&b System [ nssadmin FE A (7 winkle: & MyCustom!
] N (] Users » [ profile r (A
| Macintosh HD » [ radino [ Background

2 (] Shared
[ TVRUGGEDD1 = @ winkler
[ winkier Bl

rker * (] DSMLogFiles » & winkler.ave
es

Projects
. [ synced Avid Projects

In the screenshot above, the user in question is “winkler.” You can see that the
“‘winkler” user folder contains the “winkler” settings as well as a subfolder for the
custom-created settings that are named “MyCustomSettings”.

This screenshot is an example of a project
file with a few organizational folders and bins
created. Note that the project name
“PostGuide Demo” is displayed and the
loaded user profile is called

: :F':k ﬁ “MyCustomSettings”. Your project file name,
¥ &5 Sequences profile name, and specific folders and bins

:::tﬁ;ﬁﬁ-. ﬁ will differ. Remember that if you just created
¥ & Video a new user profile, you’ll want to verify that

: ::':hﬁ“;mp'* Footage ﬁ the settings on the previous pages are

W Imported Footage ax updated and correct under the new profile,

w Still Images 4K before proceeding.
4] 0

Now that your user and project settings are
verified, you can create some folders and bins. With the project window selected, hit
3B-N to create a new bin and using the fast menu, you can choose to create a new
folder. Now is also a good time to hit 3d8-S and save everything!

In the screenshot above, see that there are two bins for sequences? It's a good idea to
keep one bin for your currently open sequence, and one bin for all past versions of the
sequence. This aids in organization and also keeping the open bin sizes to a minimum.
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AMA WORKFLOW OVERVIEW

The next section of the guide will walk you through an AMA, or “Avid Media Access”
workflow, which is the most likely workflow you will use while editing with files originally
shot on an SD or CF card, which you have already copied to your editing hard drive.
But first, here is an overview and explanation of AMA and how it will impact you as an
editor— read it, it's important!

The AMA workflow allows you to very quickly add media to your project without waiting
for it to import/transcode. This greatly speeds up post production media ingesting, or
acquisition to the editing system. Rather than importing media and waiting for it to
transcode, or convert, to a native Avid compression format (such as the most commonly
used DNxHD), clips added to your project through AMA appear in your project as links
to the original files on your hard drive. This saves time and hard drive space (you only
have the 1 original file to deal with instead of that plus an imported/transcoded file), but
comes at an operational cost ... system performance.

Here’s a scenario for you — you have recorded 6 hours of footage using the Panasonic
HMC150. At 11GB/hr for AVCHD, that's 66GB of files. If you were to import all of that
footage into Avid at the DNxHD 145 MXF specification (720p/59.94), it would take
approximately 1x real time (6 hours) to create the new Avid media files. That
compression comes at a data save rate of 64GB/hr of media, so the files on your hard
drive after importing equate to 66GB + 384GB (6 x 64) = 450GB. Suddenly you’ve lost
a day of editing and almost half of your 1TB hard drive free space — and you haven’t
even started editing yet. With AMA, you only have the 66GB used and it takes just a
few minutes for Avid to link the files.

However, here’s the issue about system performance - Avid AMA utilizes the computer
processor and installed codecs (compressor and decompressor program helpers) to
decode the highly compressed media and use it in real time for playback and editing in
Avid. The process will seem effortless and easy to you, but it is very intense for the
computer system. Therefore, if you are doing anything other than playing back AMA
media in real time (including scrubbing, fast forward, rewind, and reverse play), the
system may seem sluggish and tend to freeze up faster-than-real-time motion, or pause
a bit more than you’d expect before playing. Since this isn’t a smooth way to edit, it is
best to use AMA media to establish a rough cut sequence or timeline, and then
transcode only the media you need within your timeline to an Avid-native compression
format such as DNxHD. This will take a little time (but significantly less than if you
imported all of your media) and will greatly improve system performance for the clips
you want to use in more refined editing. You can transcode additional media from its
AMA linked format to DNxHD at any time, from within a sequence or a bin.
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Recall the previous example, with 6 hours of media using 66GB of space. Once you
use the AMA linked media to set up a rough cut, let’s say the rough cut for your 10
minute final project is currently 30 minutes long. You can transcode this media to
DNxHD to get much smoother playback in all speeds and directions, and increase
system performance and reliability. With 30 minutes of AVCHD / AMA linked footage, it
will take about 30 minutes to transcode — again, 1x real-time. But it will only create
32GB of new files (remember, 64GB per hour using DNxHD 145 MXF). You'll then be
able to edit with the native Avid files, which will greatly increase system speed and
performance, over what you experienced with AMA. Rather than waiting the full 6 hours
to import/transcode 384GB of files, you wait one half hour (a nice lunch break) and now
you’ve only used 66GB + 32GB = 98GB of your 1TB hard drive. Sound better? Let’s
get started. You'll be editing with AMA media faster than it took you to read this
explanation!

LINKING TO AMA FILES

Ii"’ Edit Bin Clip Output Sd

By this point, you should have already connected your primary Newdin =N
editing hard drive (with media saved on it) to the computer, opened ED:\;'L{?BEM "
your Avid project, and created some organizational folders and/or Close Seected Bins sew
bins. Create and open a new bin (or open an existing bin) for the SSCD

files you are about to link. Then, go to the File menu and select *‘f’
AMA Link... )
In this example, we’re going to AMA link some AVCHD/MTS files Sf-z‘ifi

shot on an HMC150. Since AMA linking does not take up any

additional hard drive space, it's usually easier to link all media files | oo
and then individually eliminate linked clips from your Avid project, e
rather than linking files one by one, hoping you got the right ones!

Link to Velume for Export...

Next you will have to browse for [ e —
the folder that contains the ) L — ]
media files. If you have kept
your SD/CF card folder
structure intact, this could take
a few clicks through your editing
drive — and be sure you are
using your editing drive and not
your backup drive! Once you
see the media clips, click within
the clip window and hit 38-A (or
Ctrl-A on a PC) to select all the
clips. Then click Open.

£
(]
o

|
|

EIEIE}
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After clicking Open, it will seem that nothing happens. Wait a few seconds and a status
box will show up and the screen or windows may flicker. Each file you selected is now
being AMA linked within the project. Depending on the number of files you selected to
link, this could take a few minutes. When the process is done, your bin will contain all
the clips and each clip icon will include a chain link. & This indicates that the clip is a
linked clip, and not a native/imported/transcoded clip. Hit ¢8-S (or Ctrl-S on a PC) to
save your bin before moving forward (hint - if you see an asterisk (*) in the title bar of
the bin, it means you’ve made a change that hasn’t yet been saved, as in the

screenshot below).

DEII:IH
| +AMAExampleFootage @ x |

| |wame |creatonDate | Duaton orwe | WN-OUT | MarkiN | warkour [Tacs st |vido |

8/26/14 2:48:54 PM TVRUGGEDOL 16;16;51;15 H.264 (720p 59.94) IE:
8/26/14 2:48:52 PM 40 TVRUGGEDO1 16;1631;26  H.264 (720p 59.94) |

8/26/14 2:48:51 PM TVRUGGEDO1 16;16;11;17
8/26/14 2:48:49 PM TVRUGGEDODL 16;15;55;24
8/26/14 2:48:48 PM TVRUGGEDO1 00;03;06;13
8/26/14 2:48:46 PM TVRUGGEDDL 00,02;55;05

TIPS FOR WORKING WITH AMA MEDIA

Now that you've linked some files via AMA, you can view them and edit them into a
sequence as if they were regularly imported clips. However, keep in mind that system
performance may be a little sluggish and choppy if you try to play backward, faster
speed forward or backward, or jump around a lot within the clip or sequence. Again,
this is normal due to the processor-intensive work that must be done to decode the
highly compressed footage, and real-time processing of this is hard enough. While in
AMA, you should have smooth forward playback and regular speed, but the system may
drop frames in playback when transitioning from one AMA clip to another in sequence.
When you transcode the media to an Avid native format (next section), you will have
improved variable speed and dual direction playback capability.

et )| !f you are getting frustrated with choppy playback, you can
lower the video quality mode in Avid. At the bottom of the

timeline window is a small icon that may be greenu,

yellow nor half-green and half-yellowa. Clicking it will
cycle through the three different video quality modes.
Green is highest quality, half/half is good quality (usually
this is selected by default), and yellow is low-quality. Try
the yellow low-quality mode if you have excessive sluggish
performance — this will only change how Avid presents the media to you. When you get
to the point of exporting your work, you will want to be in the half/half mode for rough
cuts and the green mode for your final cut to ensure the best quality rendering and
exporting possible.
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Since the files you linked are still named the same as the actual files created by the
camera, it's a good idea to sort the bin first by file name / number. Click on the “Name”
heading in the bin, and then hit 38-E to sort by that column. It will be hard to keep track

of all those clip numbers. You can rename a clip in Avid, and Avid will “remember” its
FAEES

original file name / number, as well as
where it exists on your hard drive. Click the ED:"HI':I

name of the clip and type to rename it. .. Sedalia zoomat_8/3 o, Name
Once you’ve renamed it, you can right-click ES g;;';:ﬁ ; e
on the clip icon and choose the option Get E : M‘;";R
Info. In the example to the right, you can E8 00007 : =
see that the clip now named DVCPro zoom BN . "o

E2 ooo10 ] Audio Bit Depth
Video File Format

in is actually referencing the source file
named 00002.MTS. Other info about the
clip also appears for your review. To see
where the file is saved on the drive, you can right-click the clip icon and choose the
option to Reveal File instead of Get Info. A Finder window will open with the file
selected/highlighted.

ER 00011 < Video
E8 00012 2 Audio Format
E2 00013

goooo0oooooO

You can subclip your AMA media just like regular media clips. If you have an interview
that is 10 minutes long and all you need from it is a 15-second sound bite, you can
subclip this section... and then eventually only transcode this portion rather than the
entire clip.

You can delete a clip from your bin simply by selecting it (by
clicking the clip icon) and pressing delete on the keyboard. Avid
will ask what you want to delete — in this case, select the option to
Delete 1 master clip(s) and hit OK. This will delete your project’s
AMA link to the media file(s) you selected, leaving the actual file(s)
on the hard drive safe and unchanged.

When re-opening a project that contains AMA clips, Avid will attempt to re-establish
links with all the media. This process could take a few seconds or minutes, depending
on the amount of AMA linking in your project. Let your project “settle” after opening it,
otherwise the system may freeze or crash. If no matter what you do, the system
freezes when you open a project, try holding down the Option key (Alt on a PC) while
you click OK on the Select Project window, and continue depressing that key while the
project loads. Holding this key during loading will force the project to open with all bins
closed, rather than open as they were at the end of your last edit session.

Here’s an idea - if all you want to do is review or log your footage, you do not have to
load it in Avid. You could watch it in VLC Media Player or other media playback
software without opening Avid. However, you will not see any timecode information.
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What many people use is the clip counter,
with each clip starting at 00:00 and
progressing up (all players should show
this). You can view a clip counter in Avid
just as easily as you can view timecode — :
just choose Absolute from the timecode .
drop-down menu at the top of the Composer
window. Keep in mind that many DSLR S—
cameras, such as the Canon 7D, do not u

record actual timecode — for these, you have
no choice but to reference the clip counter.

When editing, don’t add effects or transitions to AMA clips in your sequence.

Even basic dissolves can be problematic. Effects on AMA clips will cause a lot of stress
on the computer processor, especially for real-time effects that don’t normally need to
be rendered to be seen in a draft mode. The computer will try to simultaneously decode
the AMA clip and apply the video effect to it, which can cause decreased performance,
dropped frames, or errors and ultimately a system freeze or crash. Use AMA to
establish your rough cuts, and leave the effects and other transitions to be added after
transcoding.

There are numerous other tips, tricks and shortcuts for working with AMA functions, and
clips in general — consult the help menus and online resources to discover more about
bin views, sorting, sifting, searching, creating your own custom bin column headings,
and countless other features that will enhance your productivity!
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TRANSCODING AMA TO DNxHD: CLIPS ONLY

You can transcode individual clips or entire
sequences — first, we’ll go through the clip
method. Select any subclip, clip, or multiple
clips in your bin that you want to transcode,
and they’ll be highlighted in blue. Right-click
on the clip(s) and select
Consolidate/Transcode.

e —

In the resulting window, choose the
Transcode radio button.

Next, making sure the
option for Video and audio
on the same drive(s) is
checked, select your hard
drive from the drive list. On
the right, Avid will indicate
how much space is
required to perform the
transcode, and how much
space is currently available.

Check the box that says
Transcode only AMA
linked media since this is
exactly what you want to
do! In the Target Video
Resolution section, click
the drop-down menu and
select your desired DNxHD
MXF option. If you are working with 720p/59.94 media, this should be DNxHD 145
MXF. The drop-down menu here is the same menu you saw in the Media Creation
settings when you first starting work on your project. If your media was recorded at the
wrong audio sample rate or audio bit depth, this is where you could transcode the audio
format to the proper 48 kHz and 16 bit (or whatever you are working with). Usually you
can leave these options unchecked and format unchanged. Background transcoding is
now an option in newer versions of Avid Media Composer. However, testing on Rowan
systems was intermittent in terms of successful completion. At this time, we
recommend that you do NOT choose to run the transcode in the background. When
you are ready to proceed, click Transcode.
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When you transcode, Avid takes the
original file and creates a new file that
uses the compression you specified. As
... B |ong as you are not using the lowest
compression settings, the audio/video
media itself will not seem noticeably different. Since DNxHD is less compressed than
AVCHD or other MP4/H.264 media, Avid can work with it faster and smoother than
other compressed formats, but it takes up more space. The transcoded file will actually
exist as one independent file for video, and one independent file for each audio track —
most often, you will have your V1, A1, and A2 tracking exist as separate MXF files
(though within the Avid application, they will be treated as one master media clip).
These files are automatically saved in the Avid MediaFiles folder on the hard drive you
specified in the transcode options window. Avid maintains the MediaFiles folder. DO
NOT rename, move, erase, add anything to, or remove anything from, this folder on
your hard drive. Just let it sit there untouched — Avid will manage it for you. Again, do
not directly add any files to, or remove any files from, the Avid MediaFiles folder.

The transcode process will take approximately 1x real time — so if you're transcoding a
20-second clip, it'll take about 20 seconds. When the transcode process is complete,
you will see a new clip created in the same bin as the old clip — except it will have an
appendage to the name and the clip icon will no longer have the link icon in it. Also you
can see the difference in listed video format between the original clip and the new clip.
Note that the originally selected clip, not the new one, remains highlighted.

1 B DWCPro zoom innew 11  SME2012 15:19:46 20,02 DixHD 145 (HDF 20800

It's suggested (but not required) that you rename the appendage of the clip name to
something shorter — so instead of .new.01, use something to denote that this file is the
transcoded version (author’s suggestion is to use .xc or .dnxhd, because .tc could be
confused with timecode info). Just try not to have two clips of the same name in the
same bin (or project, for that matter) to avoid confusion. You might also want to move
all your transcoded clips to new bins so you aren’t confusing AMA and Transcoded
media in the same bin. Ultimately, how you organize these clips is up to you. But from
this point forward, whenever you want to use this clip, make sure you are editing with
the transcoded version and not the AMA linked version.
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TRANSCODING AMA TO DNxHD: SEQUENCES

In this section, we’ll look at transcoding a rough cut sequence that uses all AMA media
to one that uses all DNxHD media, for refined editing.

Depending on how long your sequence is, or needs to be, you may want to work on
smaller sequences so that you don’t have a long collection of AMA clips. Some users
have reported issues with AMA sequences longer than thirty minutes. The more
AMA clips you have in a sequence, the harder the
computer has to work.

Once you have your sequence ready for transcoding,
right-click on it in its bin and select
Consolidate/Transcode.

In the resulting window, choose the Transcode radio button.

Next, making sure the
option for Video and audio
on the same drive(s) is
checked, select your hard
drive from the drive list. On
the right, Avid will indicate
how much space is
required to perform the
transcode, and how much
space is currently available.

In the topmost section on
the right, select the option
to Create new sequence.
Also, you can specify the
new media file Handle
length. This means that
when a new media file is
created, its starting “mark
in” and ending “mark out”
points can be extended however many frames you specify. This is good if you may
need to extend a clip for the purposes of a fade or other effect. It is recommend that
you specify a handle length of at least 2 seconds — when working with 720p/59.94, your
footage format is 60 frames per second, so 120 frames would provide 2 seconds. If the
media does not have sufficient handle time, as much handle time as is available within
your specification will be used (i.e., if you marked in 10 frames from the beginning of a

TV Post-Production Guide ~ September 2014 Page 41



clip, the handle length for that clip can only be 10 frames because no additional media
exists).

Check the box that says Transcode only AMA linked media since this is exactly what
you want to do! In the Target Video Resolution section, click the drop-down menu and
select your desired DNxHD MXF option. If you are working with 720p/59.94 media, this
should be DNxHD 145 MXF. The drop-down menu here is the same menu you saw in
the Media Creation settings when you first starting work on your project. If your media
was recorded at the wrong audio sample rate or audio bit depth, this is where you could
transcode the audio format to the proper 48 kHz and 16 bit (or whatever you are
working with). Usually you can leave these options unchecked and format unchanged.
Background transcoding is now an option in newer versions of Avid Media Composer.
However, testing on Rowan systems was intermittent in terms of successful completion.
At this time, we recommend that you do NOT choose to run the transcode in the
background. When you are ready to proceed, click Transcode.

When you transcode, Avid takes the
original file and creates a new file that
uses the compression you specified. As
long as you are not using the lowest
compression settings, the audio/video
media itself will not seem noticeably different. Since DNxHD is less compressed than
AVCHD or other MP4/H.264 media, Avid can work with it faster and smoother than
other compressed formats, but it takes up more space. Each transcoded file will
actually exist as one independent file for video, and one independent file for each audio
track — most often, you will have your V1, A1, and A2 tracking exist as separate MXF
files (though within the Avid application, they will be treated as one master media clip).
These files are automatically saved in the Avid MediaFiles folder on the hard drive you
specified in the transcode options window. Avid maintains the MediaFiles folder. DO
NOT rename, move, erase, add anything to, or remove anything from, this folder on
your hard drive. Just let it sit there untouched — Avid will manage it for you. Again, do
not directly add any files to, or remove any files from, the Avid MediaFiles folder.

e—

Transcoding from AMA to

real-time. When the transcode I:l S

00006 mewy. 01 BHE201 2 16:35:44 25
process is complete, you will I:I m 00014 nesw. 01 BIER2012 16:33.44 14,27
see a new sequence created in 1 B Godzilla zoomout.new. 01 SHER012 163344 10,03
[ BR 00012.new.0d BHME201 2 16:35 44 7144
the same bin as the old © 1 ED DWCPro zoom innew.0l SMBI2012 16:33 44 500
[ | EH DemoSedquence_01 Transcoded 01 SMEMR2012 16:33 44 34,24
an appendage to the name. -
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The icon remains the same however. Also, new transcoded media files for all of the
clips within the sequence now exist in the same bin as the transcoded sequence. Note
that the originally selected sequence, not the new one, remains highlighted/selected.

You may want to rename the appendage of clip and sequence names to something
shorter — so instead of .Transcoded.01 or .new.01, use something to denote that this file
is the transcoded version (author’s suggestion is to use .xc or .dnxhd, because .tc could
be confused with timecode info). Just try not to have two clips or sequences of the
same name in the same bin (or project, for that matter) to avoid confusion. You could
even move all your transcoded material to new bins — and it’s highly recommended that
you move all clips out of a bin called Sequences! Ultimately, how you organize these
clips is up to you. But from this point forward, whenever you want to use media from
this sequence, make sure you are editing with the transcoded version and not the AMA
linked version. Since this was your rough cut, you can use the transcoded sequence to
begin making finer cuts. You will notice that the playback sluggishness is mostly gone
when you use DNxHD media instead of AMA linked media.

IMPORTING NON-AMA MEDIA

Not all media can be linked via the AMA process, and sometimes you may know what
file you definitely want in your project right away, and you have time to wait for it to
import. When you import a file, you are essentially performing an instant transcode
from the original file format to a native Avid file format — except the only version that
exists in your Avid project is the transcoded version. Still images, graphics, animation
compositions, and standalone audio files (voiceovers, sound effects and music) are
good examples of files you would likely choose to import rather than AMA link.

You will want to verify the Import
Settings options, available from the
Settings list in the project window,
pictured to the right. “Image” pertains
to both still images and motion video.
There is also a section for Audio, and
the others you probably won’t need to
adjust or even use. Depending on the
sources you are importing, especially
graphics and animations, you may
need to do some trial-and-error to see
which import option is the best. You
may need to adjust the import option
for each file or batch of files you import.
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The Media Creation settings, which
you should have adjusted earlier,
control the file compression and
formatting to be used — as you
probably guessed by now, it's DNxHD
145 MXF for 720p/59.94 media. Media
Creation also specifies which hard
drive the media will be imported to /
saved on — make sure before you import that YOUR hard drive is the one selected.

When importing, use the project window to select and open the bin to which you want to
import your files. Then go to the File menu and choose Import...

Select files to Import

[(«]> (2 B m] v | = - | [ & Graphics ™ Q

Browse to and select the

x| Dwn otimaa file(s) you want to import.
i e MOEMSIMS P You have one last chance
e here to change the Video

O Do Resolution, Hard Drive, and
1 LabBozEdit-04 Import Options — verify

! DOCDRIVEO4
| FOURMAC
[ FOURFAT

> o>

everything and then click
Open to import the file(s).

[ options.c ] Enable: [ Any :
Resolution:

DhNaHD 145 WXE o) (g | = ncceoor 8 The time it takes to import

o~ the file(s) will depend on the

e type and size of the file(s).
Graphics and short
audio/music tracks are relatively fast; footage/video media files will take a bit of time.
For footage/video media files, expect the import process to take 1x the running time of
the media. So if you’re importing a 1-minute video clip, it will take about a minute to
import. Once imported, the file appears as a clip in your bin and you can work with it
like any other DNxHD clip.

| Cancel | | Open |

» NOTE: The Avid software documentation recommends that to
improve system performance and playback smoothness, you
avoid mixing AMA linked and non-AMA imported video media
within one sequence.
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RE-IMPORTING EXTERNALLY MODIFIED FILES USING BATCH IMPORT

Sometimes you will need to make changes to imported files outside of Avid, and re-load
those files into your project. If you import them again, you will have to manually re-edit
anything that you used into your sequences. However, you can use the batch import
procedure to re-import and refresh all sequences using those imported items in just one
step.

For example, you have a graphic that you made in Photoshop and exported as a .jpg.
You imported this .jpg into your project and edited it into your sequence. But later on,
you decided to make changes to the graphic and want Avid to use the new graphic
instead of the old one. You re-saved the .jpg file outside of the Avid program (using the
same file name as before) and want to bring it in.

€@ Rowan University €@ RowanUniversity

Find the graphic in your Avid bin and right-click on it, and
choose Batch Import... =

When asked about Offline or All clips, choose All clips.

Next, select the clips to batch import. If the new
files are not in the same location or path as the
originally imported files (Avid remembers!), choose
“Set File Location” to manually choose the new
files. Also in this window, you can choose to import
at a different resolution and change import settings
for this batch import process. When you're ready,
choose Import.
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The graphic will import and in a few seconds, automatically be updated in your
sequence. Unlike editing within Avid, this is a “destructive” edit in that you cannot
restore the previous version of the graphic unless you batch import it again — ANY use
of the graphic within your project will be updated. Don’t forget to save your project after
the changes!

i i ety et
| BB DemoSequence 01 Transcoded.0L 8/26/14 3:35:57 PM Oﬂj\e{ O{“j‘e{
WA o JAS o
Q¥ QWO

| K RowanUniversityFullScreen.jpg 8/26/14 3:48:48 PM

A NOTE ABOUT SPANNED CLIPS

If you were recording media on your HMC150 camera for an extended period of time,
then you may have a “spanned clip.” Recall that the CF and SD cards are formatted as
FAT32, and with that format no single file can be larger than 4GB. At the data recording
rate for the HMC150, this means that when you hit about 20 minutes of elapsed
recording time in one shot, your file is roughly 4GB in size. Rather than shut down and
stop recording, the HMC150 camera creates a new file on-the-fly for recording the rest
of your footage. The software then links the two files so that as the first one ends, it
automatically triggers the second linked file to continue recording as if it was really one
continuous file. Thus, your one recorded media clip spans two files — hence, a
“spanned clip.” Note: As of this writing, the Canon 7D will stop recording after 12
minutes (4GB) and will not create a spanned clip.

So, how does this affect you? If the editing or playback software on your computer
doesn’t know how to read the information, or metadata, within a spanned clip, you may
get an error message or the file will not play. In versions of Avid Media Composer
software prior to version 6, the files would seem to import/transcode in an endless loop,
never stopping — yet no new files were created and in effect, nothing happened. In
versions of the Avid software from version 6 and above, this error has been resolved
and no longer poses a problem.
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WORKING WITH MIXED FORMATS AND FRAME RATES

Although ideally you want all of your media to be of the same format and frame rate,
and you want your project settings to match this format and frame rate, this isn’t always
possible due to the numerous shooting formats in existence. The Avid software is built
to allow you to work with a variety of formats and frame rates all within one project and
sequence. However, the ability for Avid to playback a mixed format sequence will be
based on the capability of the computer system.

For the sake of an example, let’s say you are editing a project at 720p/59.94 and want
to use footage shot in the 1080p/23.976 format. You can easily AMA link this footage
into your project. But unless you import or transcode it, it will remain in its own format
and will not conform to the project format. This means that before you transcode it, Avid
will attempt to convert it on-the-fly during playback and editing in your timeline. This can
get very processor-intensive for the system, and your playback performance may suffer.

If you transcode, the footage will be converted to the project format and you can work
with it natively. You will get the informational warning pictured below. Choose Convert
and your 1080p/23.976 clips will be transcoded and converted to 720p/59.94.

If, when you are all done editing and are ready to export, you have footage of mixed
formats and frame rates in your sequence, you must transcode or perform a video
mixdown of the entire sequence so it conforms to one format, start to finish. Otherwise,
you will have errors in the exported file, the file won’t play at all, or Avid will prohibit you
from exporting altogether. Procedures for transcoding sequences are detailed in an
earlier section of this guide; Video Mixdown procedures are detailed in the Exporting
section of this guide.

Note that while you are working in one project format (i.e., 720p/59.94) you may be
unable to switch to another format for transcoding, rendering or output (i.e., you cannot
choose to transcode contents of a 720p/59.94 project to 1080p/23.976).
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To get around this, you can create a new project at the format and rate you want to
convert your footage or sequence to, and open a bin from your existing project while
in the new project.

Go to the fast menu of the Project Window and choose Open Bin...
and browse for the specific bin inside the other project. When the
bin opens, Duplicate the clip(s) or sequence(s) you want to use,
and drag the duplicate into a new bin in the new project. Then
you can transcode, and your media will now exist within this project
at your new project’s format and frame rate.

This is useful if you know you need to output in a specific format that isn’t the native
format of your project, and let Avid do all the rendering and transcoding rather than
another program or conversion software. At Rowan, we can use Avid to down-convert
HD materials to SD for archiving on tape or use in the TV studios — we take the clip(s)
or sequence(s) from an HD project and open them in an SD project bin, and use Avid to
transcode to SD so that we can then record it to DVCPro tape (remember, HD media is
not compatible with SD VTRs). You may never have to worry about these multi-
format, multi-project procedures if all of your original media is recorded in the same
format as your project, and format you work in is the format you want to export.
Hopefully, it will be!
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CAPTURING AND BATCH CAPTURING FROM VIDEOTAPE

*Please note that the screenshots in this section are taken from Avid Media Composer
PC version 5. The procedures for capturing and batch capturing have not changed
between version 5 and the current version, so know that the procedures are still the
same although the screen shots in this guide section may appear different from the Avid
interface that you are using.

At Rowan, we do not have any HD tape systems, so if you are capturing from tape you
must be working with standard definition footage in a standard definition (NTSC 30i)
project. In Avid, “capturing” is the term given to the process of recording media from
tape into the computer, but this process is also commonly known as digitizing or
ingesting. There are several ways to capture material in Avid, but first we need to verify
some settings and make sure the media is saved where we want it to be saved.

STARTUP

1. Make sure your VTR is turned on and connected to your computer workstation
(this may involve using a firewire router depending on the lab and system you are
using) before you start the Avid software.

2. Launch the Avid software, and while it loads...

3. On the front of the VTR is a control that allows “Local” or “Remote” control of the
deck. Make sure that the switch is in “Remote” mode (this will disable all of the
transport control buttons).

4. Also on the front of the VTR is an input switch. Set it to “Option” for the firewire
interface.
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SETTINGS: MEDIA CREATION

Media Creation - Current 2l Once you have launched a
project, you need to verify
some settings for capture.
Open the MEDIA CREATION
settings and click the Capture
tab. This will show the
resolution for capturing
(should be DV 25 411 MXF)
and also the target drives for
saving the material (some

other programs may refer to this as your “Scratch Disk” settings). You want to make
sure that the video and audio both go to the same drive and that drive is your primary
editing hard drive — this is the same as when you verified Media Creation settings at the
start of your project. Once you have chosen your drive, click “Apply to All” — this will
make all functions save to that chosen drive.

Capture Settings - Current @

SETTINGS: CAPTURE

You'll want to verify the correct
capturing settings before you begin
capturing so as to avoid problems.
These settings are detailed in another
section of the Post Production Guide.
For now, just make sure your screen
has these options selected as pictured
to the right for Capture settings.

SETTINGS: DECK CONFIGURATION

You also need to verify that the deck
configured for your Avid is the deck
you will actually be using! Locate the
Deck Configuration settings and
make sure that the selected
option is “Standard DVCPRO
VTR” or something similar. If
you open the deck settings it
should look like the image
pictured to the right.
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If not, click the “Add Channel” button and choose the option for “Firewire on OHCI”, and
then “Add Deck” and select your VTR from the drop-down list, sorted by brand. The
most typical VTR used at Rowan is the Panasonic AJ-D250P. If you are using a MiniDV
camera from Rowan, it is most likely the Panasonic DVX100BP.

SETTINGS: DECK PREFERENCES

Deck Preferences - Current &4l There is a separate setting for Deck Preferences.
Verify that it looks like the image to the left.

BASIC CAPTURING

il * ENGPract01

tep 1: Il of tti ifi
Step 1: Once all of your settings are verified, —p——

you are almost ready to capture. Before you
can start rolling tape, you must designate a
bin in your project for capturing the footage.
Create a new bin and name it depending on
what you’re going to capture. Most often,
naming the bin the same as the tape name
or ID number is best. In this example, the tape we are using is called ENGPract01.
Make sure the bin is open and click on it to activate it.

Step 2: Go to the Toolset menu and click “Capture” to Special Tools Windows _ Script  Help
. . . . Color Correction

activate this mode. A new window will appear. There < SeucelRscnd EARY

are several features you will use and adjust, and several i‘uf;f::':;g

you will not. Let’s look at the capture tool on the next Capture

Full Screen Playback

page.

Save Current
Restore Current to Default
Link Current to..,
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Record/Capture button Delete
Status Indicator

Source toggle

Capture/Log mode toggle

Capti re Tool

Source track -

selection - -

Clip name

Target bin
and comments

Capture resolution

Time left on
Audio delay control capture drive
Capture drive

Timecode

Transport controls

VTR setting

Mounted tape

Custom preroll setting Clip marks

MARK IN, timecode, goto IN, clear IN
MARK OUT, timecode, goto OUT, clear OUT
marked duration
Insert Locator, timecode, goto locator, clear locator

If your capture tool did not open to look quite like this, then you are in the logging mode.

Click the pencil icon that says LOG and this will change to the above view, which is
capture mode.
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Step 3: Verify that this tool is set up for capture by checking:

e The BIN selected is the one you are going to capture to (we're using
“‘ENGPract01”)

e The RES selected is DV 25 411 MXF

e The DRIVE selected is your primary editing drive, selected earlier in the Media
Creation settings (but you can change it here if you need to).

e You see timecode information 00:00:00:00 — not “NO DECK”

Step 4: Once you have verified all of the settings and everything is good to go, insert
your tape in the VTR. If you are using a MiniDV tape, you must use the supplied
MiniDV adapter — DO NOT insert a MiniDV tape directly into the VTR.

Step 5: After inserting the tape, Avid will ask Select Tape
what tape you've loaded. Click the “New”
button to set up a new tape identification or
select your tape from the list by clicking the
black square. DO NOT overwrite or erase any
existing tapes. If you do, it will erase Avid’s
knowledge of those tapes previously used in
the system. This will negatively affect your
ability to stay organized! Avid will only list
tapes with media already captured for your
project/system.

Jape Hame

For this project, we’ve entered the new tape name
ENGPract01 and selected it by clicking the black square
to highlight it in blue. Click OK to close the Select Tape
dialog box and return to the Capture tool.

Step 6: Avid will only display and m
play out the tracks you have

selected for capturing. At the top of the capture tool, click on the track indicators until
they light up, indicating that they are selected for capture. Remember, these are the
tracks for the SOURCE tape you just loaded. Most often, there is 1 track of video and 2
tracks of audio. You should also select the TC (timecode) track. For this example,
we’re using all four. But sometimes you may not need everything (e.g., if you've
recorded VOs to tape and have no need for the video, just deselect the video button!).
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Step 7: Using the transport controls, you can play, pause,
rewind, and fast forward the tape. You can also advance
frame-by-frame, and use the horizontal scroll control to
jog/shuttle the tape forward and backward at variable speeds. The tlmecode
information should move according to the tape position and direction.

Step 8: Cue the tape to the start of the media you want to capture. For ENGPract01,
this happens at timecode 00;02;36;16 (note the semicolons indiggdigg that this is drop-

frame timecode). Click the MARK IN button to mark in at this (B Yo0:02:36:16 | B

point, and the timecode will appear in the text box. [_"V""r-’?T'
Alternatively, you could type in the timecode and hit Enter | coco:7:13 |

(you don’t need to enter the semicolons, just type in the e wen
numbers). This is useful if you have already logged the tape : :
on paper and know the timecode values you need.

Repeat this step to locate and identify the end point of the clip, this time using the
MARK OUT button. Note that once you have an IN and OUT marked, the duration is
calculated automatically. You do not need to add any locator marks.

Step 9: Once you’'ve marked the region of media you want to capture, NAME THE CLIP!
Type in a name for the clip using any naming conventions or organization plan you’ve
created. You can also add a helpful description. These are the only two fields you can
manually enter data into at this time.

Capture Tool

T o 1 TN TR

1 g‘ ¥ Ly i
jivg d !
£ 7 T A

Willow Oak

Quercus phellos

Southedstern United States

| B 00:02:36:15 | Be Il
fey ! 1» — =
& | ooo025320 | aE T
00;00;17;13 |
O T
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Step 10: When everything is set, click the Record/Capture button at the top left corner of
the Capture tool. Avid will tell the VTR to rewind to a preroll point a few seconds before
the marked IN point. The tape will then roll and Avid will start capturing the media at the
exact timecode you specified. The status indicator light will blink red while capture is in
progress. Just sit back and watch the magic happen. When playback reaches the end
timecode you specified, capture will end and the deck will pause or stop the tape a few
seconds later.

SIC RN NVAUCISN | SuperBin: ENGPract01
the clip captured

successfully. Go
back to your bin and
locate the captured
clip. The name of the clip will be highlighted in case you want to change its name (or
forgot to in the previous step and it appears as an Untitled clip). Double-click on the
video clip icon to open it in either the source monitor or a new viewer window. Play the
clip and spot-check it for any audio or video glitches. When you’re satisfied, you can go
back to the capture tool and repeat these steps to capture more media. Remember that
if you insert a new tape, you click “NEW” in the select tape window and give it a unique
name. DO NOT overwrite or erase existing tape names! And don’t forget to SAVE your
project after capturing new material!

If your clip fails to capture, there are numerous possible causes. The most frequent
problems include:

e The timecode you entered manually (by typing it in) doesn’t exist — recheck the
timecode!

e There is a timecode break within the clip and the math doesn’t work out (you’d
need to capture two separate clips).

e The starting timecode is too close to the start of the tape or a timecode break,
and a suitable preroll point can’t be found. Adjust the MARK IN point a little later
and/or set a custom preroll of 1 second.

e Your MiniDV tape won'’t play properly — video looks sped up and has jagged
edges, no audio. This usually means you shot in “LP” mode (should have been
“SP”), and the VTRs don’t play back LP mode. You’ll need to use a MiniDV
camera for capturing instead of a DVCPro VTR.
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LOGGING AND BATCH CAPTURING

If you mastered basic capturing, congratulations! If you’ve been doing the basic
capturing for numerous clips, you’re probably getting impatient. Capturing is a real-time
process, so every time that you enter a clip for capture, you have to sit and wait for the
system to play it in real time and capture it. Wouldn't it be great if there was a way to
log in all the timecodes at once, and then let the machine capture everything by itself?
Well, you're in luck... if you use the LOG and BATCH CAPTURE features of Avid Media
Composer.

Step 1: Go through the setup procedures as before, including creating/selecting a bin,
opening the Capture toolset and loading your tape in the VTR as before. Name the new
tape or pick it from the list of tapes to select.

Step 2: At the top of the Capture tool click Capture Tool
the CAP button to change to the logging
mode. The capture tool window gets much
smaller and no longer contains anything
pertinent to drives or actual capturing!

The CAP button is now a pencil and says
LOG. Note also that the Record/Capture
button has been replaced by a MARK IN
button. Track, Naming, Transport and

Timecode areas are the same as before.

Step 3: As before, use the transport
controls to cue the tape to the starting
point of the media you want to capture.
Click the MARK IN button (either in the
timecode area or at the top left where
Record/Capture used to be).

Step 4: In logging mode, it's best to enter a clip name BEFORE choosing Mark out,
because there is a single button that will MARK OUT and enter the clip into your bin in
one step. If you click this before naming the clip, it'll log it as an Untitled Clip — you don’t
want that! So enter a clip Name now.
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Step 5: After naming your clip, cue the tape to the end of the media you want captured
for this clip. Now you can do one of two things:

e Click the MARK OUT button E in the timecode info area to mark out at this
point, and the information will stay active for your review, then click the LOG
button | 2| at the upper left of the Capture tool to log the clip to the selected bin.

OR...

e Click the LOG & MARK OUT button at the upper left of the Capture tool to
instantly MARK OUT at this point AND log the clip to the selected bin. If you do
this, the clip info will disappear and the capture tool will be ready and waiting for
you to enter the next timecode and clip name values.

Step 6: Verify that the clip was logged successfully. Go back to your bin and locate the
captured clip. The name of the clip will be highlighted in case you want to change its
name (or forgot to in the previous step and it appears as an Untitled clip).

A Ext road WS zm MS white pi... Q‘i@

] cic)

Note that unlike the previously captured clip, this clip does
not have any information for Drive (the hard drive onto
which the clip is saved). If you double-click on the video
clip icon to open it in either the source monitor or a new
viewer window, you will see a Media Offline message.
This is because you have only logged the clip information
but haven’t actually captured any media. You can play
the clip for its entire duration, but no media is present! Go
back to the capture tool and repeat these steps to log
more media.

Step 7: OPTIONAL. This is a step devoted to helping you organize your media while
logging and preparing to capture. Depending on how you like to work, or what you have
been instructed to do for your project, you may want to only log the clips you know you'll
use, then capture them. Or, you may want to log every clip on your tape and then
capture what you think you'll use. Or even still, you might log and capture everything!
This last option might take up a lot of hard drive space depending on how big your
project is, so the general rule of thumb is to log everything, but capture only what you
think you'll actually use. Often times you will have multiple takes or versions of the
same thing, and you’ll need a way to designate what’s good and what’s not. You can
use the Description field to enter comments, or create your custom fields. If this is
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something that interests you, do a search in Avid Help for “Adding Customized Columns
to a Bin” for this information.

Step 8: You've got your clips logged, now it's time to BATCH CAPTURE! Before you
do, make sure to SAVE all your work NOW! Then, in your bin, select the clips you want
to capture. You can select multiple clips at once — this sets up a “batch” of files to
capture. In the screenshot below, 3 of the 4 offline clips have been selected for batch
capturing.

it Bin W&l Output Special Tools

Step 9: Go to the Clip menu and
select Batch Capture. In the
resulting dialog box, make sure
that “Offline media only” is
checked. The number of clips
you’ve chosen to batch capture is
listed. Do not select the “extend” oS
option. Then click OK to begin ComoldotelTrarstode,
the batch capture process.

Batch Capture

M New Sequence

New Title...

Freeze Frame

Center Pan
Remove Pan
Apply Gain

Decompose. ..
Refresh Mation Adapters

Step 10: Avid may ask you to mount the Avid Media Composer
correct tape in the VTR. If you are 0
prompted, make sure the correct tape is
loaded and then click “Mounted” to begin
the batch capture.

The Avid system will control the deck and begin the batch capture process. The clips
will be captured in chronological order on the tape. The system will behave as it did in
the basic capture mode, except that it will do all of the clips you selected back to back
without any input from youl!

As the batch capture progress, you will be given _
status updates in the capture tool window, just
above the Clip name area.

Like basic capture, batch capture is a real-time process. If you have chosen to batch
capture a lot of clips, then this is the perfect time to let the machine take over and go
outside to get some fresh air, eat lunch (but don’t bring the food back into the lab), or
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take a power nap. However, it's best to only batch capture clips on the same tape at
one time — otherwise the system will prompt you to insert a different tape and wait until
you do.

When the capture is completed, you'll get a message telling Avid Media Composer
you the result. If some clips could not be batch captured,
you may need to go back and try them individually, keeping
in mind that if your clip fails to capture, there are numerous
possible causes. The most frequent problems include:

e The timecode you entered manually (by typing it in) doesn’t exist — recheck the
timecode!

e There is a timecode break within the clip and the math doesn’t work out (you’d
need to capture two separate clips).

e The starting timecode is too close to the start of the tape or a timecode break,
and a suitable preroll point can’t be found. Adjust the MARK IN point a little later
and/or set a custom preroll of 1 second.

e Your MiniDV tape won’t play properly — video looks sped up and has jagged
edges, no audio. This usually means you shot in “LP” mode (should have been
“SP”), and the VTRs don’t play back LP mode. You'll need to use a MiniDV
camera for capturing instead of a DVCPro VTR.

Step 11: Verify that the clips batch captured successfully. Go back to your bin and
locate the captured clips — they should still be highlighted in blue. Notice that there is
now information in the Drive column! Select a single clip, and double-click on the video
clip icon to open the clip. Play the clip and spot-check it for any audio or video glitches.
Do this for any or all of the clips you just batch captured.

When you're satisfied, you can go back to the capture tool and repeat the previous
steps to log and batch capture more media. Remember that if you insert a new tape,
you click “NEW?” in the select tape window and give it a unique name. DO NOT
overwrite or erase existing tape names! And don’t forget to SAVE your project!
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CREATING MEDIA CLIPS BASED ON LOGGING SPREADSHEETS

*Please note that the screenshots in this section are taken from Avid Media Composer
PC version 5. The procedures have not changed between version 5 and the current
version, so know that the procedures are still the same although the screen shots in this
guide section may appear different from the Avid interface that you are using.

The Avid Media Composer software allows you to log and capture your footage within
the program. You can choose to capture as you log, or log all clips and batch capture
later. However, to log footage for your project, ideally you need your Avid system, your
Avid project, and a VTR connected — this doesn’t happen all the time. If you want to log
elsewhere where you can find a VTR but not necessarily the Avid software, you can log
shots to a simple spreadsheet — the best option is to use Microsoft Excel or Google
Docs — and then import this information into your Avid project at a later time for
capturing. The following instructions detail this process with step-by-step directions.

STEP 1 — Log your footage in a simple spreadsheet

Create a spreadsheet document using Google docs, Excel, or another spreadsheet
program. For best results, dedicate a sheet for each tape you log. Set your sheet up
with the following columns (see also the screenshot on the next page):

e Name - The name for the media clip can be anything to help you organize your
shots. Follow the guidelines for good naming conventions. Do not use any
symbols or quotation marks.

e Tracks - The video/audio tracks you intend to capture. Usually VA1A2 (Video,
Audio 1, Audio 2). You do not have to select all tracks if you do not need them
(i.e., a voiceover might just be A1 or A2).

e Start - The starting timecode of the clip (use HH;MM;SS;FF for drop frame TC)

e End - The ending timecode of the clip (use HH;MM;SS;FF for drop frame TC)

e *Custom™* - Any custom columns you want to create (i.e., Description, Comments,
Rating, Talent, etc.) that will help you in the sorting/sifting process later, that are
not already reserved in the system — reserved columns are listed at the end of
these instructions.

As you log, your spreadsheet may begin to look like the image on the next page.
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STEP 2 — Save the spreadsheet with specific text formatting

Save your spreadsheet document. Also, save a backup copy just in case. Now, you
need to save the sheet as a new text-only file that Avid can understand. Make the file

name the same as the Tape Name or Tape ID accord

ing to how you’re organized.

Go to File (or the “Office” button) and choose “Save As...” and “Other Formats.” In
the “Save as type:” drop-down box, choose “Text (Tab delimited) (*.txt)”, then name
your file with the .txt extension (you may want to add the word “text” to the name so you
know it's not the actual spreadsheet file). Choose where to save it, and then click Save.

Save As @@
Save in: ‘ [) Shared Documents v : @ @A X ] j -
B My Recent | () Avid Marquee
Documents || avid Medialog
@ Desktop [0 Default Avid MC RTF User Settings
|_)Shared Avid Projects
My ) shared Musi
‘D (=) Shared Music
ZOcuments uﬂ Shared Pictures
- B i
< Chcptler ™ shared video
g My Metwork
Places
File name: |NextFrameTape01.txt \;}'
Save asLYPe! | Text (Tab delimited) (*.txt) [
Excel Template (*.xltx) ~
Excel Macro-Enabled Template (*.xltm) =

XML Spreadsheet 2003 (*.xml)
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If you get an error message like the one below, just say “Yes.” Then close/quit your
spreadsheet program (if you don’t close it, Avid can’t work with it).

Microsoft Office Excel

MextFrameTape01.txt may contain features that are not compatible with Text (Tab delimited). Do you want to keep the workbook in this Format?

-
o ) + To keep this format, which leaves out any incompatible features, click Yes.
« To preserve the features, click Mo, Then save a copy in the latest Excel format,
+ To see what might be lost, click Help.

[Yes][No][HeIp]

STEP 3 — Convert the text file to an Avid format file

Now it's time to let Avid do some work. [ —
Go to Start > All Programs = Avid ngtﬂ;@!z,b@m el

and click on the program called “Avid Log
Exchange”. A very simple, blank window opens.

Go to File > Import > Tabbed file and choose
the text file you just saved.

When the “Import Header Options” dialog box
appears, choose the options

Import Header Options

that correspond to your

media. Your choices should gp:n o e

be “NTSC” and “29.97”. e - me

Even if you shoot in 24P With | seceep. R

the DVX100 or SDX900 S e 70 o

cameras, choose “29.97”. Exit £z

Film Type you can leave e |

alone. Then click OK. £ 16mm o
& Fmm L

Carcel | ok |
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If you have no errors in your import, a new text file will appear that will have some
heading information as well as the text information from your spreadsheet. The
columns may or may not match up with the corresponding data — DO NOT make

adjustments to make it neat and tidy.

Avid Log Exchange - [NextFrameTape01.ale]

File Edit Convert Options VYiew Window Help =%
Disle| &|(@ &2 =a=

Heading

FIELD_DELIN TABS

AUDIO_FORMAT 48kHz

ITAPE NextFrameTapeOl

FP35 29.97

VIDEO_FORMAT NTSC

FILM FORMAT 35M

Colunn

Name Tracks Start End Description Rating

Data

Ent box handouts CU VAlAz  00;01;02:12 00:;01:16;20 Newspaper box of Film Festival handouts 2

Bigscreen WS VALAZ 00;01;16;20 00:;01:44;:26 Jumbo screen of Philly Fest promo 2

Banner WS VALAZ2 00;01:44;26 00;01:54;01 Philly fest banner 1

screen WS full promo wid VAlAZ 00;01;54;01 00;02;55;19 Jumbo screen of full promo best static shot 3

MS clock zm WS screen VALAZ 00;02:55;:19 00:03:14;02 Clock tower shakey zoom out and pan to screen 3

MS banner pan to clock VAlAZ  00;03;14:02 00:;03;26;06 Film fest banner pan to clock not bad 3

M5 zm CU clock tower VAlAZ  00:;03;30;01 00:;03;34;11 Clock tower zoom in 2

MS pan across banner VALAZ 00;03:34;11 00;03;51;25 Pan Across banner 4

CU screen zm WS street VALAZ  00:03:51:25 00:;04;31;27 CU of Jumbo Screen zoom out to street x2 2

Ready NUM

Save the file (File > Save). Instead of a .txt extension, the file now has an .ale

extension (for Avid Log Exchange).

Now go to File > Clean ALE... and choose the file you are working with. This
command will re-check the file for errors. If there are no errors, it will seem like nothing
happened — this is good! Once the file is cleaned, SAVE again. Then close the Avid

Log Exchange Program.

STEP 4: Importing the ALE file into an Avid bin

Now open the Avid Media Composer application
and open your project.

Since the information you are going to import
pertains to a specific tape, make a new bin in
your project and name it the same as your tape.
This makes it easier to organize in the early
batch capture stage of post production. It's also
a good idea to start a new bin from scratch in
case of an error during the import.

With the new bin active and selected,
go to File > Import, just as if you were
importing pictures or music. When the dialog
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Select files to Import

PIX

Look in: l_) Shared Documents

|2 Avid Marquee

|5 avid Medialog

|2 Default Avid MC RTF User Settings
) 5hared Avid Projects

:‘dshared Music

;g_’ﬂshared Pictures

:‘gshared Video

@ NextFrameTape0l.ale

~| & ® ek B

File name: |

Files of type: |Shot Log Files [*.ale)

Graphic Files —
Options... i

CamCutter Files (*.bin,”.spl)
AAF Files (*.aaf]

MXF Files (*.mxf)

‘Windows Media Files [*.wmy]
MetaSync Files [*.aeo)

Audio Files (*.bwf," wav,”.mp3," aif," aiff,".cdc
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box appears, browse to the location you saved the .ale file. Under the drop-down for
“Files of type” choose “Shot Log Files (*.ale)” and your log file should appear. Click
“Open!!.

The bin should then fill up with the media information you specified in the log file. Keep
in mind that these are the “Master Clips” which hold all the information, not the media
itself. This you’ll need to batch capture in the next step.

:ll SuperBin: * NextFrame Tape01

STEP 5: Batch Capture

You’re not going to want to capture all of your clips — that would fill up more hard drive
space than you have and take a very long time. As you plan your EDL you can pick and
choose which clips you want. This is where a category such as “Rating” could be
handy. Maybe you only want to capture the best b-roll which you’ve rated as a “3” or a
“4”  Simply select all the clips that meet that criteria, and then batch capture. But before
you actually perform the batch capture, you need to verify some settings.

> VERIFY DROP-FRAME TIMECODE

First, if you’ve logged timecode with semicolons ( ; ) and shot
in the drop-frame timecode mode, you don’t need to do
anything.

G SuperBin: * NextFrame Tape01
TRy eiend et | :

Mew Sequence

But if you've logged with colons ( : ) and shot in drop-frame

ConsolidatefTranscode...
Promote Effects...
Demote Effects.

Center Pan
Remove Pan
Apply Gain

Change Sample Rate...

Launch in Mative Application..,

Relink...

Commit Multicam Edits

Duplicate
Remove Redundant Keyframes
et Rin Tnfa
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mode, you need to manually change your logged clips to
match the tape — otherwise Avid will tell you that you've
inserted a drop frame tape when it is expecting a non-drop
frame tape.

To do this, select all of the media clips that have colons ( :)
in your bin and right-click on the clip icon at the far left of the
bin window. Choose “Modify...” and a new dialog box opens.
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From the uppermost drop-down box, choose “Set ey
Timecode Drop/Non-drop” and then click the button that
corresponds to Drop-frame. Then click “OK” and all the
colons in the media clips you selected automatically

Set Hey Mumber Generic [Prefiz]

change to semicolons.

Set Tracks

Again, if you already had semicolons, you can skip this

Set Formet

Ste p . Set Ink Mumber Options

Set Aux Ink Number Options

> VERIFY BATCH CAPTURE SETTINGS

Due to a bug in the Log Exchange Program, the audio on
every clip is logged as 8-bit OMF audio. However, the
media you will capture is designated as 16-bit MXF audio.
Since the log information in this case is wrong, you want to
batch capture based on project, not logged, settings.

In your project window, choose the Settings tab. Find the “Capture” settings and open
them. Click on the “Batch” tab, and verify that your settings look like these:

Capture Settings - Current

| @eneral | Bateh | Edit.| |1 Media Files. | v Dptions. |

Most important is to make sure that the last three options (audio sample rate, audio
sample bit depth, and video compression) are NOT checked.
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> VERIFY MAXIMUM CAPTURE TIME

The RTF Avid stations are set to capture no more than 63 minutes of footage in one
shot. In the event that you need to batch capture a longer section of media (i.e., a
continuous take from a live event or multi-camera continuous shoot), you'’ll need to
change the time limit. On the “MXF Media Files” tab of Capture Settings, you can
change the maximum capture time to whatever you need it to be.

Once you have verified the settings, you can batch capture as though you had taken the
time to log the clips individually in Avid yourself (refer to the previous section of this
guide for Batch Capture instructions). As you can see, this process allows you to log
footage outside of Avid and import the logs into Avid for capturing later. This way, the
editor could be capturing a tape on the Avid and another group member could be

logging footage elsewhere — group multitasking!

RESERVED NAMES FOR BIN/COLUMN HEADINGS IN AVID MEDIA COMPOSER

The following names should not be used as “Custom” headings of your logging columns
unless you understand the exact formatting and use of these fields.

ASC_SAT
ASC_SOP
Audio Bit Depth
Audio Format
Audio SR
Auxiliary TCA1
CFPS
Cadence
Color
Creation Date
Disk Label
Drive
Duration
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End

FPS
Format
Frame
IN-OUT
Journalist
Lock
Mark IN
Mark OUT
Modified Date
Offline
Production
Project

Pullin
Pullout
Scene
Shoot Date
Sound TC
Soundroll
Start

Take

Tape
TapelD
Tracks
Video
Video File Format
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LOG & CAPTURE TIPS WHEN TAPES ARE SHOT WITH FREE-RUN TIMECODE

“Time-of-Day” Free-Run timecode can be used to help you match shots between
simultaneously recorded cameras. As you know, Avid doesn’t like to capture tapes with
inconsistent timecode. You will need to be very specific and careful when logging &
capturing your footage, especially around timecode jumps. Do not use Free Run
timecode unless you understand exactly what this will mean in post production. If
you’ve already shot Free Run, use the information below to help you in post production.

FIRST, go to the Settings tab and ensure the following:

Capture - General - Preroll Method: Choose Standard Timecode
Capture - General - Capture across timecode breaks (CHECKED)
Capture - Batch - Log Errors to the console and continue (CHECKED)
Capture > MXF Media Files > Capture to Multiple files, max 63 minutes
Deck Configuration - Deck Settings - Fast cue (UNCHECKED)

The problem Avid has with inconsistent timecode is in the preroll. When you mark an IN
point for media, the deck needs to rewind a short amount of time (standard is 3-6
seconds), roll forward, and then start recording on the frame you specified as your IN
point. The problem is that the deck can’t just count backwards x frames. If you set your
in point at 13;27;54.10 and the preroll is 5 seconds, Avid tells the deck to go back to
13;27;49.10. If you hadn’t been recording at this timecode (i.e., you started and your IN
is the first frame of the new recording), this clip will not be captured because the deck
does not have sufficient preroll because it can’t find the timecode it is supposed to use
at its rolling start point.

To avoid this problem, do two things. First, when logging, log your IN at least 2-3
seconds forward from the starting TC jump. You want to give Avid and the deck at least
2 seconds of consistent timecode for preroll purposes BEFORE the IN point from which
you want to start capturing. Then in the capture tool, when you are ready to digitize, set
your Custom Preroll to 1 second. This will minimize problems.
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AUDIO EDITING & MIXING IN AVID MEDIA COMPOSER

The Avid Media Composer software takes some getting used to, and most tutorials for
editing and operation are enough to get you moving in the right direction. Traditionally,
most new Avid users have the most difficulty with audio editing and mixing. The
features of this software’s audio editing capabilities are conceptually the same but
operationally different than some editing programs you have already used.

The primary function of the Avid Media Composer software is of course video editing.
However, audio is just as important (if not at times more important) than the video. For
most of your projects, you will need to do very basic audio editing and mixing of the
audio recorded with your footage, music, and sound effects. Audio editing in AMC is
based on the frames-per-second timeline you’re working with, so you can only work with
audio on a frame-by-frame basis. If you need to do more fine tuning, you can export
your audio to a program such as Avid ProTools or Adobe Audition and edit at the
sample level, then re-import the adjusted audio back into your Avid project. If you can
make your adjustments within Avid, it's quick and easy.

Audio Settings

You need to know which Audio mode you are working in...
pick one and stick with it for the duration of the project. It
WILL affect the level adjustments and mix you create!

When setting up your project, you can set the overall audio
to be Alternating L/R (stereo) or All Tracks Centered
(mono). The defaultis Alternating L/R, which means that
all odd numbered tracks are automatically panned all the
way left, and all even numbered tracks are panned
all the way right. Any centered audio would be
anything that is equal on both left and right.

At Rowan, you are instructed to record audio for
television production courses using Ch 1 as the
onboard/secondary mic, and Ch 2 as the plugged-
in/primary mic. With the default audio option set to
“Alternating L/R”, you will hear Ch 1 audio on the
left and Ch 2 audio on the right. You can always
pan the audio later, but this mode is ideal for easier identification of audio sources.
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The Track Control Panel

To prepare for audio editing and mixing in the timeline, you’ll want to set some audio
options and views. In your timeline window, locate the triangle next to the timecode
display and click it so it points left, and opens the Track Control Panel.

The Track Selector allows you to choose oo; 00; 00: 00 I T
which tracks you want to work with in audio

editing and mixing. |_| =} solo

' | |
The Toggle Waveform View will turn on/off HIMIP Mute
the audio waveform display within each i AREENE
. I T |
track clip.
: RTAS
The Plot Views drop-down menu will allow / f enabled
i i Plot | plug-ins
you to choose to view the different plotted Track Views |
adjustments on each clip within the track. selector Track
Options include: Toggle onaf;ff
Waveform
None: No plotted display View

Clip Gain: Adjustable gain level for the entire clip
Volume: Adjustable mix volume level for the clip
Pan: Adjustable pan direction for the clip

The Track On/Off toggle will turn on/off track processing and monitoring. Unlike Mute,
this will disable all effect rendering for a track during playback.

The small boxes below the above options will fill with icons representing any RTAS
enabled plug-ins you have added to your track, including limiters, compressors, gates,
echo/delay effects, etc.

Mute will mute the track, but will not deselect it.
Solo will allow you to hear just the solo-enabled track(s) and mutes all other tracks.

Simple Cutting and Fading (clip ends)

In the most basic procedure, cutting or fading audio clips in your timeline is exactly the
same as cutting or fading video clips. If you want to make a cut in your audio track, cut
the exact same way as you would if it was a video track. If you want to fade out or fade
in your audio and the start or end of a clip on your timeline, you can add a quick
transition such as a basic dissolve, just as you would add a video dissolve. Just make
sure you are only selecting the audio tracks in your track selector area, and not the
video. Note that the effect is called a “dissolve” and not a “video dissolve” because it
works on both video and audio!
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Audio Mixer: Clip Gain

You will often need to adjust the overall volume of a clip on your track — let’s say you’ve
got music you want as background but right now it’s too loud. In this method, you can
change the volume of the entire clip.

Select the track indicator button(s) (A1, A2, etc.) that contain(s) the audio you want to
adjust. You can adjust multiple tracks at the same time. Single-click on the audio clip
area so that your blue cursor is over the clip you want to adjust.

Go to the Tools menu and select Audio Mixer. . audioMixer
Make sure that you are in the Clip mode (click the
button on the far right until it says Clip).

The Audio Mixer in Clip Mode has a lot of options
which are explained in great detail in the Avid
tutorials and Help menu. For basic operation, the
blue selected track indicators at the bottom of each
mixer channel designate that tracks you previously
selected. If you need to select different tracks,
click the track indicator button on the mixer
window. You will only get track selectors and fader
controls for tracks that have audio clips on them at
that point in the timeline. If you don’t see controls
for the tracks you want to adjust, move the blue
cursor on the timeline to the correct area. If you
are using more tracks than the mixer displays, click
the numeric button with the slider icon (displayed
as 4 in this picture) to expand or shrink the
available mixer channels.

Drag the slider for the channel you want to adjust, up or down.
The text below the slider will change to show you the dB level
+ or — that you’ve changed it to. If you want to change
multiple tracks at the same time (i.e., A2 and A3 are the left
and right channels of music), click the “group” button above
the pan pot to be able to group channels together and change
them simultaneously.

Remember, this adjusts the volume level for the entire clip.
This is known as a CLIP GAIN adjustment.
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Audio Mixer: Clip Pan

You may need to pan the audio clip to the left, right, center, or somewhere in between.
Note the pan pots at the top of each channel in the previous example. A1 is panned
“L100” (left 100%), A2 is “R100” (Right 100%), and A3 is “L100” (Left 100%). This is
consistent with the “Alternating L/R” audio setup verified earlier. The audio on A2 and
A3 should really be panned opposite what they are now, as in this example they are
from a stereo music track and were edited to A2 and A3 because the voiceover already
existed on A1. And while we’re at it, the VO should not be audible only in the left
channel, but rather both equally — so we’ll pan this clip on A1 to center.

So to PAN your audio, simply click and drag the pan pot control left or right, depending
on which way you want to pan. The numeric display will change to indicate how far left
or right you go, and if you are centered it will
display “MID.” Remember to deselect the track
group option, otherwise as set in our example,
you’ll pan both A2 and A3 the same way since HID L100 F100
they are grouped together. In the example to the

right, A1 is panned center, or “MID”, A2 is panned full left, and A2 is panned full right.

-"'-._ " - —
o | @ | @

Remember, this adjusts the pan direction for the entire clip. This is known as a CLIP
PAN adjustment.

Audio Mixer: Global Track Options

Occasionally you may set a level or pan value for a clip,
and want that applied to ALL of the clips on that
particular track. Rather than changing each clip setting
one by one, you can go the Fast Menu for the Audio
Mixer and adjust ‘global’ settings.

For example, let’s say that everything on A1 throughout
your sequence is a narration, and you want all of the
clips on track 1 to be panned to MID like the current
clip. With only A1 selected (and adjusted the way you want it), go to the fast menu of
the mixer and select “Set Pan on Track — Global” and this will take the current setting
and apply it to every clip on the currently selected/active track.

TV Post-Production Guide ~ September 2014 Page 71



Audio Mixer: Automation Gain and Pan

You may need to adjust only a portion of the volume of a clip on your track — maybe the
music gets too loud in one section and you want to bring it down. In this method, you
can make a level adjustment for any part of your clip. Using the Automation Gain
system with the Audio Mixer can be a little tricky. If you don’t want to go this route, the
easier way is to use keyframes and “rubber banding” the audio — those instructions are
in the next subsection.

Select the track indicator button(s) (A1, A2, etc.) that contain(s) the audio you want to

adjust. You can adjust multiple tracks at the same time. Single-click on the audio clip
area so that your blue cursor is over the clip you want to adjust, at the start of the area
you want to adjust.

Go to the Tools menu and select Audio Mixer to
open the Audio Mixer window. On the upper right of
the mixer, a button should say Auto. If it doesn’t
(and says Clip or Live instead), just click it until Auto
appears. When you are in the Auto mode, the
background of the mixer sliders will be light blue,
rather than grey as in Clip mode.

For basic operation, the blue highlighted track
indicators indicate the tracks you enabled for editing
before opening the Audio Mixer. If you need to
select different tracks, click the track indicator
button on the mixer window. You will only get track
selectors and fader controls for tracks that have
audio clips on them at that point in the timeline. If
you don’t see controls for the tracks you want to
adjust, move the blue cursor on the timeline to the correct area. If you are using more
tracks than the mixer displays, click the numeric button with the slider icon (displayed as
4 in this picture) to expand or shrink the available mixer channels. Grouping tracks
together works here too. And this will work for both level and pan adjustments.

The approach for this mode is the same, in that you select tracks and adjust sliders.
However, in “Auto” mode, you perform a simulated real-time mix. With the cursor on
your timeline positioned at the start of the area you want to adjust, click the red record
button in the Audio Mixer window. The timeline will play and then you can control the
sliders as the timeline plays, just as if you were mixing a live recording. To stop, click
the button again. To cancel and throw away the mix while it’s still in progress, hit
Escape or click the Trash Can icon. To undo a mix once completed, just hit Ctrl-Z, the
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standard Undo function. When you play back the section you just mixed, the sliders will
move automatically to follow the mix you created. If you don'’t like it, you can record
over it again! Back in your timeline, any clips that now include this

Automation Gain control will have a purple triangle keyframe icon. !

Automation Pan works the same way — except instead of adjusting the volume level
faders in a real-time mix session, you adjust the pan pots.

By adding Automation Gain or Pan to a track, you are essentially adding a new
keyframe adjustment for the level or pan every time you make an adjustment with the
slider or pot. The Avid tutorials and help menus go into further detail on how to work in
Automation mode, but this should be enough to get you started.

Editing Audio in the Timeline Window: Keyframes

You may need to adjust only a portion of the volume of a clip on your track — maybe the
music gets too loud in one section and you want to bring it down. In this method, you
can make a level adjustment at any part of your clip by adding keyframes to a volume or
pan line, and adjusting those keyframes up or down. This is similar to adjusting audio in
other multi-track audio editing applications such as ProTools and Audition, and is often
referred to as “rubber-banding” the audio.

In the Track Control Panel, click on the Plot Views drop- T
. - [

down menu. If you want to adjust the volume of the clip, 00

choose Volume. If you want to adjust the pan (left/right), .

choose Pan. Though you can have both turned on

I
| ough | e
simultaneously, it's easier to work with them separately. It
may also help to see a waveform overlay, but this is H:;ll—"—"—”—_lﬁ
optional and you can turn it on/off at any time by toggling
the Waveform View button.

If you haven’t already done so, select the track indicator button(s) (A1, A2, etc.) that
contain(s) the audio you want to adjust. Selecting more than one track will allow you to
several tracks at once (same as grouping in the mixer).

Single-click the audio clip at the first point you want to adjust, so that your blue cursor is
over the clip you want to adjust, at the exact point you want to make an adjustment.

Insert a keyframe on the selected track by pushing the double quotation key ” on the
keyboard. You can also go to the Tools menu, select Command Palette, and go to the
FX tab and map the keyframe button to another key on your custom keyboard or to any
open button in the timeline window. The icon is a purple triangle pointing up E&4).
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If you only have one keyframe on an audio clip and try to adjust its up/down position,
this will act very much like Clip Gain or Clip Pan in that it will adjust the level for the
entire clip. You must add at least one or two more keyframes in front of or after the first
keyframe to make a slope change. The picture below shows a timeline with 3
keyframes (black triangles) added to A2 and A3.

To adjust the level / vertical position of a particular keyframe, move the mouse cursor
over a keyframe and wait until it turns into a small hand. Then you can click and drag
the keyframe up or down. For Auto Gain, moving the keyframe up raises the volume
and down lowers it. For Auto Pan, moving the keyframe up pans to the left and down
pans to the right. Release the mouse when you get the keyframe to the level you want.
Do this for all of your keyframes.

Need to move a keyframe? When the cursor turns into a hand, hold the Alt key and
click/drag left or right along the timeline.

Need to delete a keyframe? When the cursor turns into a hand over the keyframe you
want to delete, hit the Del key on the keyboard (you don’t have to click anything).

Need more vertical room in the track to adjust the keyframes? With the track indicators
still selected, push 38-L to expand the vertical space or d8-K to shrink it.
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Standard view...

After using 38-L (pushing it about 12 times — note Al is still the same size because it
isn’t selected)...

Need to adjust a lot of keyframes at once? Mark in before the first keyframe and mark
out after the last keyframe you want to change. If you adjust any one keyframe within
the marked points, all keyframes will be adjusted relationally. Note the differences
between the keyframes pictured above and below.

There are many other options and features involved with audio editing in Avid Media
Composer. Given the above procedures and explanations, you’ll be able to do some
basic audio editing and mixing. Go through the Avid tutorials, read the help documents,
and search online Avid forums for more information.
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Channel Levels and Master Mix Levels

The Audio Mixer channels include their own level indicators, showing you each
channel’s mixed level output in real-time (note that since we are using mono tracks,
there is only one indicator in each channel strip. Pan is not metered here). When you
are mixing the audio in your sequence, pay close attention to the master mix levels
displayed in the timeline window and/or in the Audio Tool. To open the Audio Tool, go
to the Tools menu and choose Audio Tool. This will open a larger audio meter that you
can move and resize as needed, with both digital and analog metering. The digital
scale is on the left and the analog equivalent scale is on the right. The Audio Tool will
show you both the Left and Right channels of main mix audio.

»)

L10o0 B1a0

How you mix and pan your clips and channels is up to you and the creative audio
design you employ for your project. But you should always make sure that no channel
exceeds the 0dB digital threshold for clipping, which is the point at which you will start to
hear distortion. If any channels are clipping, chances are your master audio mix is
clipping as well — so keep the audio “out of the red” and try to have the loudest section
of your master mixed audio no higher than -8dB digital / +12dB analog. This still gives
you some audio headroom just in case.

Just as you want to avoid audio that is too loud, you want to avoid audio that is too
quiet. For “normal” talking levels in an interview or voiceover, you should be averaging
around -20dB digital and peaking no higher than -8dB digital. Background music mixed
low should be audible but not overpowering the VO, probably a bit below -20dB digital.
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CREATING BASIC TEXT AND GRAPHICS USING THE AVID TITLE TOOL

Avid offers two graphics/titling applications with Media Composer — the Title Tool and
Avid Marquee. Many students opt to use other programs for graphics and effects work
(Adobe Photoshop, lllustrator and After Effects are most common) but for basic titling,
Avid provides solutions. Marquee is an advanced program that allows the user to
create motion graphics and graphic effects, with many advanced and 3D manipulation
options. If you want to learn more about Marquee, consult the Avid Help menus and
online tutorials.

Both applications can be accessed from the Tools menu in
Avid, at the bottom select “Title Tool Application...” If you've
never launched it before, you'll get an option to open Marquee
or Title Tool. If you check “Persist” then whichever program
you launch next will launch every time you open the “Title Tool
Application...” menu item.

Click Title Tool to open that program. It will launch as a separate application from Avid
Media Composer (but you can’t launch it unless AMC is already running).

By default, the tool will open with a transparent background, showing a still image of
whatever is cued up to the playhead/cursor on your sequence.

£
ke

PUSH
< SHTL/SLOW
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If you want to change to a solid color background, click the green “V” in the tools area to
turn off video transparency. Clicking in the black box to the left of the “V” will open a
color palette to change the background color.

Click on the “T” to enable the Type tool, and then click the cursor on the titling canvas
where you want the text to appear... then type it in! You can also draw boxes, circles,
and lines with the corresponding tools. Every element is customizable in terms of font,
style, border, shadow, and colors for all elements. The Object and Alignment menus
will provide you with additional options for how each element will appear. Note that by
default, the view quality is low-draft mode. To see exactly how everything will appear
once rendered, go to the Object menu and choose Preview.

You can also create titles that Crawl (scroll left/right) and Roll (scroll up/down). Click
the button for the type of motion title you want, and either a horizontal or vertical scroll
bar, along with page number indicator, will appear.

When you are ready to save your title, go to the
AvidTitleTool File menu and choose “Save Title
As...”

You’'ll be prompted to enter the Title Name, Bin to
save it to, Drive to save the media file to, and the
Resolution. Then click Save and the title will be
saved in the bin you specified. You can then treat
it like any other media file and edit it into your
sequence. ltis highly recommended that you Mark In a few seconds into the title, and
Mark Out and few seconds before the end of the title, to give ample handles on your
graphic so you can add fades or other transitions. If you used a transparent
background, when you load the title into the source monitor it will appear with a black
background. Once you add the title to a video layer or track above the video, it will
again be transparent.

8/26/14 3:29:44 PM

nalie Weirlkeld

§/26/14 2:48:30 PM
B/26/14 2:48:34 PM
8/26/14 2:48:35 PM
B/26/14 2:48:36 PM
8/26/14 2:48:38 PM
B/26/14 2:48:39 PM
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If you made a mistake or want to re-edit the title, hold the
Option key on the keyboard while you double-click on the title
in the bin, and the Title Tool will re-launch and automatically
load that title for editing. You may see a dialog box asking if
you want to “Promote this title to Marquee?” If you choose this
option, it will load the title in 806 Acid Til Tool
Marquee instead of the Title Tool
for editing. Usually, if you used
the Title Tool to create the
graphic, choose “No” to remain
using the Title Tool for editing.
You can choose to persist and
Avid won’t ask you about this
again. Make changes and re-
save the Title. Depending on
what changes you make, you
may have to re-edit the title into
your sequence again.

If you created a crawling or rolling title, the procedure for editing its duration in
your sequence is not what you’d expect. Don’t do what you think is natural... you
have to do it the way Avid wants it to be done!

Create and save the crawling or rolling title. Load it in the source monitor and edit it in
its entirety — full length Marked In at the beginning and Marked Out at the end — into
your sequence. Then, use the Trim Mode tool to roll back the length of the title clip to
the duration you want it to be. When rendered, the speed of the scroll will update
automatically to fit the time allotted for the clip. If you want the scroll slower, extend the
clip’s duration using the trim mode tool. If you want it faster, shorten the clip using the
trim mode tool. If you “add edit” or remove a section of the scrolling title clip, the scroll
will simply cut off at that point — not speed up to fit the new time. Always use trim mode
when shortening/lengthening the scrolling title, or when you want to change the scrolling
speed.

Consult the online tutorials and help resources for additional information about working
with titles created in Title Tool and Avid Marquee.
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EXPORTING A SEQUENCE

To get your sequence out of Avid, you will need to export it to a playable media format —
most often, this is a QuickTime Movie. Here is a suggested procedure for exporting
your sequence.

1)
2)
3)
4)
5)

» IMPORTANT! If you are using AMA media, you must transcode

your entire sequence to DNxHD MXF before exporting (details
in a previous section) if your sequence contains both AMA and
transcoded media. If you attempt to export a sequence that
contains mostly AMA media, and/or is longer than 20 minutes
with AMA media, you are at an increased risk for problems
during the rendering and exporting processes. Always
transcode before exporting!

Save your project by clicking on the project window, and hitting 38-S to save.
Open the sequence you want to export by double-clicking on it from in its bin.
Click the sequence in its bin once to select it.

Right-click the sequence and select the Duplicate option.

Locate the duplicated sequence in the bin and rename it to the name of the file
that you want to export it as (so, perhaps something like
TV2_EditProject_YourLastName_Final)

Double-click the duplicated sequence you've just renamed to open it for editing.

Clear any In/Out marks, and then select all of the video and audio track selectors
to enable them for editing. Also click the square video display box to the left of
the indicator for the top-most video track, to make sure that track and everything
below it will be visible.

Insert-edit two seconds of black at the beginning of the sequence, so that the first
frame of video for your sequence (or first frame of your fade from black, etc.)
starts at 02:00. Then, add in two seconds of black at the end of the sequence,
so that the last frame of video of your project is followed by black for two
seconds. Black can be created by importing a full-frame black image, or creating
a title with a black background and no text. Don't just leave empty space.

Make sure that the timeline for your sequence is complete and ends when your
project ends (i.e., no blank space or extra media at the end of the sequence). To
remove blank space, first select all audio and video tracks. Then, mark in at the
end of your project (or end of 2 seconds of black), and mark out at the end of the
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timeline. Then hit “x” to extract the empty section and bring the end of the
timeline to coincide with the end of your project.

10) Make sure that all audio and video tracks are selected/enabled and turned on.
Mark In at the beginning of the timeline and Mark Out at the end.
The entire timeline will be highlighted.

11)  Go to the Clip menu and choose Render In/Out... to render all effects in the
entire sequence. Choose to render on your designated editing drive. Make sure
that you have transcoded all of your AMA media to DNxHD before rendering
effects.

12)  If your sequence is short (under 20 minutes) and contains all media of the same
format and frame rate, you can probably skip this step. But in some cases, you
may need to perform a Video Mixdown of your sequence. A Video Mixdown will
re-render all of the clips and effects within the designated marked area, using the
enabled tracks, into one new video track/clip. You may need to perform a Video
Mixdown of your sequence, or a section of your sequence, if any of the following
occur:

a) The sequence or any clips/effects in the sequence do not render, or you
encounter an error (including system freeze / endless loop) during rendering.

b) Your sequence contains many video tracks and the system performance is
sluggish in areas featuring multiple active tracks with complex effects (usually
8 or more).

c) Your sequence contains media at different formats and/or frame rates (this will
be indicated by a green dot on the clip icon and the frame rate in parenthesis
next to the clip name in the timeline).

d) You have limited hard drive space and want to skip the transcode process for
individual clips, and transcode the entire sequence as one new clip.

To perform a Video Mixdown, Mark In and Mark Out around the area you want to
mixdown. Then go to the Special menu and choose Video Mixdown... In the
resulting options box, you must choose which bin you want the new clip to be
saved to, on which drive (your editing drive), and the appropriate resolution.
When you click OK, a new clip will be rendered. You can then create a duplicate
sequence from which to work from, and replace the previously marked area of
your sequence with the newly created clip. Then work with this sequence
moving forward in the exporting process, which uses the mixdown version of part
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or all of your original sequence, depending on the area you marked before
performing the mixdown.

13) When you are all done rendering and/or performing the Video Mixdown as
needed, re-save the project one more time by clicking the project window and
hitting 38-S.

14)  Single-click the sequence you want to export in its bin. Then go to the File menu
and choose Export...

15) When the “Export As...” dialog box appears, you need to choose options for
exporting and verify them. First choose the drive and folder location to which
you want to save the file. Also verify the intended file name. By default, the
file name is the same as the sequence name, but may be shortened due to a
limit of characters in the file name.

Next, you must choose the type of export you want to perform, and there are
several options. The most often used are “Same As Source” (which in this guide
is referred to as Option 1) and “H.264” (Option 2). Both are detailed in the
following pages, and you will need to decide which option is better for what you
need to do. Most often, students choose the Same As Source option, but you'll
need to decide for yourself. Here are the major differences:

Parameter Option 1: Same As Source Option 2: H.264
User-specified;
if using transcoded media, this
will be DNxHD 145 MXF in
QuickTime codec
Export Speed 1x real-time 10x real-time
(for a 5-minute sequence) (5 minutes) (50 minutes)
Various; at DNxHD 145 MXF,
approximately 18 MB/sec

Export Compression QuickTime H.264

Export File Size Approx. 2 MB/sec

(for a 5-minute sequence) (5.4 GB) (600 MB)
Will only play on a computer Will only play on a
Export Compatibility with Avid DNxHD codec computer with H.264
installed codec installed
Direct Upload to YouTube, No; file must be compressed ves
Vimeo, etc. using Adobe Media Encoder )

Most often, you will want to export “Same As Source” from Avid and use Adobe
Media Encoder to further compress for all deliverable locations and types (online,
web, DVD, BD). AME provides more compression options and works much faster
than Avid’'s compression engine for anything other than “Same As Source.”

More information about AME begins on page 88 of this guide. If “Same As
Source” does not work or errors occur, use the H.264 option.
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EXPORT OPTION 1: SAME AS SOURCE, NO COMPRESSION

Look at the Export Setting drop-down selection. You have a lot of options to
choose from, and each export setting will create a file with different parameters.
Most often, you want to choose the QuickTime Movie SaS option. Then click
the Options... button and verify that your options window looks like the one
pictured below with the indicated options selected.

Export As: QuickTime Movie

If you choose Use Marks, only the
area of the sequence between Mark-In
and Mark-Out points will be exported.

If you choose Use Enabled Tracks,
only the selected/enabled tracks in
your sequence will be exported.

Same As Source will export the
sequence to a file that uses the same
codec as the source material (when
transcoded, this will be DNxHD MXF
at the compression value you specified
(145)).

Video and Audio will export both.

Video Format is RGB.
Color Levels are RGB.

Audio Format (click to check) is
Stereo.

Display Aspect Ratio is that of your
project — usually this is simply listed as
16:9 with the frame size of your
footage — in this case, 16:9
(1280x720).

Once you have verified these settings, click Save to return to the Export As...
dialog box, and then click Save to begin the exporting process. A Same As
Source export will take roughly real-time — so a 5 minute sequence will take 5
minutes to export.

When finished, use Adobe Media Encoder to convert the exported QuickTime
movie to an MP4 H.264 file suitable for upload to Vimeo, YouTube, the TV
Server DropBox, or other locations requiring a compressed file. See the
instructions on pages 88-90.
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EXPORT OPTION 2: EXPORT & COMPRESS USING AVID H.264

An ALTERNATE way to export your sequence is useful if you are limited on hard
drive space or want Avid to export a file that is ready for upload to a service such
as YouTube, Vimeo, or easier sharing via online resources due to a smaller file
size (any files exported using the Same As Source option will need to be
compressed in another program like Sorenson Squeeze). In this export setting,
Avid will both export and convert your sequence to a highly compressed format.
Note that this will take much longer than if Avid only did the export, but the file
will already be compressed for upload/sharing. You may need to do some trial-
and-error testing, and adjust some settings, to make this process work best for
you. But here is a suggested method for exporting to a compressed format:

Look again at the Export Setting drop-down selection. Choose the QuickTime
Movie H.264 option. Then click the Options... button and verify that your
options window looks like the one pictured below with the indicated options
selected.

Export As: QuickTime Movie

If you choose Use Marks, only
the area of the sequence
between Mark-In and Mark-Out
points will be exported.

If you choose Use Enabled
Tracks, only the
selected/enabled tracks in your
sequence will be exported.

Choose Custom and click
Format Options...
(explanations on next page)

Video and Audio will export
both.

Set Width x Height to the same
format as the footage in your
project, and Size to Fit.

Color Levels are RGB.

Audio Format (click to check) is
Stereo.

Display Aspect Ratio is that of
your project — usually this is
simply listed as 16:9 with the
frame size of your footage —in
this case, 16:9 (1280x720).
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Format Options for Video (click Settings...)

Compression Type: H.264
Frame Rate: Current
Key Frames: Automatic

DO NOT CHECK Frame Reordering

Compressor: High

Encoding: Best Quality (multi-pass)

Data Rate: Automatic
Do not turn on any Filters

Make sure Size is Compressor Native

Format Options for Sound (click Settings...)

Format: Linear PCM

Channels: Stereo (L R)

Rate: 48.000 kHz

Render Settings Quality: Better

Linear PCM Settings: Sample Size 16

Movie Settings

™ Video

Settings...

Filter...

Size...

Allow T

@Sound

Settings

Compression: H.264
Quality: High
Encoding mede: multi-pass

ranscoding

Format: Integer (Big Endian)
Sample rate: 48.000 kHz
Sample size: 16-bit
Channels: Stereo (L R)

Prepare for Internet Streaming

Do Not Check Prepare for Internet Streaming Fast Start
Cancel | | OK |
Standard Video Compression Settings "
Sound Settings
Compression Type: | H.264
Eation Datalilaie Format: Linear PCM B
Frame Rate: | Current :| fps Data Rate: \,i:,\Aumma[ic
(_) Restrict to kbits /sec Channels: Stereo (L R) v
Key Frames: (s) Automatic
) Every EEATIEE Optimized for: | Download Rate: 48.000 @ kHz
(Al
Frame Reordering Show Advanced Settings
Compressor Preview Render Settings:
Quality
Quality: | Better
Least low  Medium  High Best Linear PCM Settings:
Sample size: | 16 + | bits
Encoding: (s) Best quality (Multi-pass) Little Endian
(_) Faster encode (Single-pass) . .
= Floating Point
Unsigned
Cancel | [ OK \ Cancel |L‘

Once you have verified these settings, click OK in each window and then Save to
return to the Export As... dialog box, and then click Save to begin the exporting
process. An H.264 conversion export will take a long time to export — roughly
10x real-time. So if you have a 5 minute sequence, it will take at least 50
minutes to convert and export. In most cases, you may find that Adobe Media
Encoder can do the H.264 compression, and many other compressions, much
faster than Avid if you simply export with Option 1 (Same As Source) and load
this source in Adobe Media Encoder for processing (details to follow).
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16)

17)

No matter which export option you’ve gone with, always load the exported file in
a player application for viewing outside of Avid, to verify proper playback. Check
your audio and video levels and lip sync, and make sure the tracks you selected
for export were exported, and the area you marked for export (or the entire
sequence) was exported. We have found that the best player for testing Avid
exports is VLC Media Player. Some QuickTime format files will not natively play
in QuickTime Player under OSX 9. If you try to open a QuickTime file and
QuickTime Player attempts to convert it, cancel/close the player and open with
VLC instead. Note that playback may stutter or have other problems if the Avid
application is still open in the background.

If you encountered any problems in exporting, or the exported file isn’t quite right,
go back into Avid, re-edit and fix the areas that need fixing, and re-export. The
“Use Marks” option in exporting is especially useful if you only need to check that
a certain area or section of your sequence can be exported properly — this way
you needn’t export the entire sequence to see if what you fixed in editing will be
fixed in the export.

Once you have successfully exported your sequence into a QuickTime movie that exists
outside of Avid, you can do whatever you need to do to submit it for your class and
archive it for your own purposes. This may involve one or more of the following:

Submit the QuickTime movie export to the TV Data Server DropBox (instructions
on the following page)

Upload the movie to YouTube, Vimeo, or another online service (if you didn’t
export at H.264, this will require compression using Adobe Media Encoder,
instructions on the following pages)

Burn the movie to DVD or Blu-Ray Disc (instructions on the following pages)

If you are satisfied with your export, save your project and completely QUIT Avid before
moving on. And don’t forget to copy your project file from the local computer system
you your own hard drive so you can take it with you!
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ACCESSING THE TV DATA SERVER

Depending on your project, you may need to access source files from or save your
exported files to the TV Data Server. For most major TV projects, you are required to
submit your final export QuickTime movie file or compressed H.264 file to the TV Data
Server DropBox. Individual lab assignments or practice work may not need to be
copied to the server — check with your Instructor or Lab Assistant to confirm.

If you are working on a PC, check the Rowan TV Production Resources website for the
current login instructions.

On a Mac, with the Finder menu bar active, click on the Go menu and choose
“Connect to Server...” In the list should already be the correct path. If not, type in:

0.0

smb://rowanads.rowan.edu/common/tvdatal/  sewerases

smb://rowanads.rowan.edu/common/tvdatal/ L+ L Q@

Connect to Server

1

Then click Connect. A new Finder window will ‘“;‘_‘j“:::jlwanads_mmledummmmmu

open showing the contents of the TV Data -—

Server. Also, the server volume will be L

mounted on the desktop. If you have vl ¢ prowse | [ Comect]

been instructed to download files from the server, browse to the appropriate folder and
copy/paste the files from the server to a folder on your hard drive.

If you are uploading files, locate the DropBox folder. You can’t click on it, open it, or
see what’s in it — this is normal. Click and drag your exported and/or compressed
files to this folder location — make sure you are dragging them to the DropBox folder and
not another nearby folder. This will copy and submit your files to a secure location.

If you attempt to re-copy a file, you will get an access denied error. Simply rename the
file with a different name and you'll be able to drop it in the box again. If you submit
multiple files, your instructor will only save and grade the most recent file version of
each file type required. Once a file has been copied into the DropBox, only staff and
faculty with access permissions can get to your file — no tampering by other students!

When uploading a file to the TV Data Server DropBox, be sure to include your
class, name/group, and project title. Do not simply put “My Project”!!!
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COMPRESSING WITH ADOBE MEDIA ENCODER

You will most likely need to compress or “squeeze” your exported QuickTime movie into
a different compression format for easier sharing and online use, and/or if you plan on
making a DVD or Blu-Ray disc. For most operations, you will find that Adobe Media
Encoder is faster and provides more options than Avid. Keep in mind that Avid is a
video editing application that happens to have compression capabilities, but Adobe
Media Encoder’s sole purpose is compression — and it does it well!

» IMPORTANT! If you are using an online service for your video uploads and
internet playback, you may need to experiment with settings to determine
which compression format(s) your choice of online service likes best.
Consult the video uploading / help information for your service to find
specifications for file formats and compression types, data rates, and if
there are any file size limitations or daily/weekly upload limits for your
account. Not all services are created equal.

Launch Adobe Media Encoder by single-clicking its icon in the dock.

In the upper left corner of the encoder window, click the Add (+) button to add files to
the encoding queue, or drag files directly into the window from a Finder window.

Next, you need to specify the compression format. Click the format drop-down to
change to the format you want to use. Then you’ll choose a specific preset from a pre-
existing template and verify the settings, or create a new one with custom settings.

You can add additional files for compression, and also add additional export formats for
each file. When ready to compress, hit the green arrow Play button in the upper right
corner of the window to start the compression job. The process will run and indicate
“Complete” or “Done” when finished. As compression is computer processor-
intensive, do not run any other applications or do anything else on the computer
while the compression process is running. Different compressions will take different
amounts of time to complete.

The recommended settings for different compressions are on the following pages.
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RECOMMENDED H.264 COMPRESSION

This will make a standalone, self-contained file with both video and audio, ideal for
sharing or uploading to an online video service such as Vimeo or YouTube.

In the Format drop-down, choose H.264.

In the Preset drop-down, choose the
YouTube HD preset that best B B
matches your project size and rate. ~ I Demosaquence_0L.mov o b
Note that most online video services
support 29.97 fps as the highest frame rate, so even if your project is 59.94 fps, choose
29.97. For projects at the recommended 720/60p (59.94fps), the best preset to start

with is YouTube HD 720p 29.97.

v H.264 v YouTube HD 720p 29.97 Volume...ts/DemoSequence_01.mp4 Ready

Single-click on the yellow preset listed (in this case, YouTubeHD 720p 29.97) and a full
export settings window will open, listing all properties of the source file as well as the
expected properties of the file to be output/compressed.

0.0.0 Export Settings

Output

¥ Export Settings
Source Scaling: ' Scale To Fit
Format H.264
Preset Custom
Comments
Output Name: [
v Export Video vV Export Audio

v Summary

Output: /Volume.../PostGuide Demo Files/Exports/DemoSequence_01.mp4
1280x720 (1.0), 29.97 fps, Progressive
CBR, Target 5.00 Mbps
AAC, 320 kbps, 48 kHz, Stereo

Source: Clip, DemoSequence_01.mov
1280x720 (1.0), 59.94 fps, Progressive, 00;00;38;23
48000 Hz, Stereo

Video

¥ Basic Video Settings
Match Source

Width: 1,280

Height

Frame Rate: | 29.97
Field Order: | Progressive
Aspect: | Square Pixels (1.0)
TV Standard:  + NTSC
Profile: | High
Level: 3.1

Render at Maximum Depth

¥ Bitrate Settings

Bitrate Encoding CBR

Target Bitrate [Mbps]

Use Maximum Render Quality

01;00;01;48 00;00;38;23 Use Frame Blending
i) Estimated File Size: 24 MB

Source Range: ' Entire Clip Metadata... Cancel
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If you make any changes to the parameters, the indicated Preset will change from what
you selected to “Custom” — this is fine. Look for the following info and check settings:

Format: H.264
Preset: What you selected, or Custom
Comments:  [blank]
Output Name: You can choose to keep the file name or change it by clicking on it.
Export video and export audio should both be checked.
In the Summary section, the frame size parameters (i.e., 1280x720) should match.
In the Video tab...
Width & Height should match source.
Frame rate should match source or be 29.97 maximum.
Field order should match source (interlaced or progressive).
Aspect should match source (usually Square Pixels (1.0) for HD content).
TV Standard should be NTSC

Profile & Level are dependent upon other settings and help the compressed video
conform to certain standards. Unless you know what you’re doing, leave these alone.

Bitrate Settings — this is where you can make some adjustments to control the size and
quality of the compressed file. Encoding options include Constant Bit Rate (CBR) and
Variable Bit Rate (VBR) with pass count options. If you are trying for the smallest file size
but best quality possible, you'll want VBR. However, this mode takes the longest. If you
need to compress quickly and want a constant quality throughout, choose CBR. ltis
recommended that for H.264 destined for online services, you use a minimum of 5 Mbps
for the rate. For better quality, increase this number but that will also increase the overall
file size, which the program estimates for you at the bottom of the window. For standard
course projects going to a shared service account, use 5 Mbps. For files being hosted on
your personal account, you can go higher.

In the Audio tab...

Audio Format & Codec should be AAC, with 48000 Hz as the sample rate, in Stereo.
Leave Audio Quality at High and the Bitrate at 320 kbps.

After verifying these settings, you can click OK to close the export settings window and
either add more presets, add more files and presets, or click the green play button to
begin the compression process.
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RECOMMENDED MPEG-2 HD COMPRESSION FOR BLU-RAY DISC

This will make two elementary stream media files, one for audio and one for video, that
you can load into your Blu-Ray authoring program (i.e., Adobe Encore) and burn a
playable Blu-Ray disc. The files may not be playable outside of the authoring program.

As of this writing, the appropriate presets for MPEG2 HD BR and MPEG 2 DVD are not
properly installed on systems. Once these presets are installed, these pages will be
updated with the appropriate screenshots and settings to be verified.
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This page is intentionally blank as a space holder for MPEG2 HD BD compression
settings.
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RECOMMENDED MPEG-2 SD COMPRESSION FOR DVD

This will make two elementary stream media files, one for audio and one for video, that
you can load into your DVD authoring program (i.e., Adobe Encore) and burn a playable
DVD. The files may not be playable outside of the authoring program.

As of this writing, the appropriate presets for MPEG2 HD BR and MPEG 2 DVD are not
properly installed on systems. Once these presets are installed, these pages will be
updated with the appropriate screenshots and settings to be verified.
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This page is intentionally blank as a space holder for MPEG2 compression settings.
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DVD OR BLU-RAY DISC BURNING WITH ADOBE ENCORE

As of this writing, Adobe Encore is not installed on lab machines, but will be by mid-
semester. These pages and screenshots will be updated accordingly.

Adobe Encore is just one of the many disc authoring applications on the market, but this
one is installed on each Avid lab system. As it provides you with many options for
creating a playable disc of your project, only the very basic procedures are detailed
here. Consult Help menus, online resources, and Lynda.com for advanced techniques
and additional options.

For rough cuts, personal copies, and most festival/contest submissions you should
make DVDs. For final screening versions and your own master copy, you can make a
Blu-Ray. The College will archive your final project to DVD or Blu-Ray for archiving,
and you can make copies using your own blank discs. However, often you will want to
author your own disc, include other projects, special features, etc. Note that blank Blu-
Ray discs are usually twice as expensive as blank DVDs.

Prior to using Adobe Encore, you should compress your file to MPEG-2 SD (DVD) or
MPEG-2 HD (Blu-Ray) specifications using Sorenson Squeeze and the instructions on
the previous pages. Though Encore does have its own built-in encoding software,
Sorenson Squeeze does the job both faster and better.

If you are making a DVD, you will use the burner already installed in the computer. If
you are making a Blu-Ray, you will need to obtain and connect a Blu-Ray drive burner
to your computer using the supplied USB cable, and power-on the drive unit. Some
software may auto-load and the hardware will initialize, and you may receive
notifications of this on the computer screen. Once the unit is online and ready, you can
start Adobe Encore. Always make sure the Blu-Ray drive unit is connected and running
BEFORE launching the Encore software!

Launch the Adobe Encore software (you can find it in the Adobe CS5.5 folder on the
desktop) and at the splash screen, choose to create a New Project. You will need to
save the project (with a logical name, and to your own hard drive) and choose the
authoring mode. Also go to the Default Transcode Settings... option and verify:

FOR DVD: Automatic Transcoding Max. Bitrate = 8.0 Mbps
Video Transcoding (grayed out, specified by source file)
Audio Transcoding: Dolby Digital

FOR B-R:  Automatic Transcoding Max. Bitrate = 25.0 Mbps
Codec: MPEG-2
Dimensions: (match your source — most likely 1280x720)
Frame Rate: (match your source — most likely 59.94)
Audio Transcoding: Dolby Digital

After verifying file name, save location, and all settings, click OK to save and open your
new project.
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In the project window, click the Build tab to verify basic settings. Format should be
DVD or Blu-Ray, and Output should be the respective Disc option. The Destination
option should be the appropriate recorder. Use the internal DVD burner for DVDs, and
the external Blu-Ray drive for Blu-Rays (yes, the Blu-Ray drive will burn DVDs, but the
internal drive will be faster). You can also verify disc info, set copy protection, and
change other options.

Click the Project tab and then go to the File menu and choose Import As... Timeline.
Then browse to find the VIDEO file you made using Sorenson — it will have the file
extension of .m2v. Click Open to open and import the file, automatically creating an
Encore timeline in the process. Be patient as it opens. When it comes in, you will see
the timeline and video file loaded in your project. Since this is the first file you've
loaded, Encore automatically sets it as the “First Play” item for your disc — you can see
the play icon over the timeline icon.

Project > T = Monitor >
v

Name . Type Duration
o3 DemoSeq...C_Final_Blu-ray 720p60 Timeline 00:00:34:24
IE DemoSeq..inal_Blu-ray 720p60.m2v MPEG video  00:00:34:24

Y 0. @ 4«
DemoSeq_01_XC_Final_Blu-ray 720p60 ' v
Timeline: Source: 20: 00:00:17:04

00:00:34:08
Lyl l [

You need to bring in the AUDIO file separately — when using elementary streams, both
the audio and video files will not be imported together. Go back to the File menu and
this time, choose Import As... Asset. Browse to find and click on the file with the audio
extension — for HD/Blu-Ray, it'll be .ac3. For SD/DVD, it'll be .m2a. Click Open, and
the file will be added to your project — but not the previously created timeline. You will
need to do this manually. Click and drag the audio file to the Audio 1 track in the
timeline. This audio clip should be the same length as the video clip. You can play the
timeline to verify proper audio-video sync. In Encore, each audio file is treated as a
different track, no matter how the audio file is formatted — mono, stereo, or surround
sound — you'’ll only see one file and one track. If you had a second audio file for
producer/director commentary, you’d put this on Audio 2.
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If you want to add other files, repeat the previous procedure to add VIDEO files as
Timelines and AUDIO files as Assets, remembering to drag-and-drop each audio file
into a timeline to match with its video file.

For each timeline you will need to specify some —
properties. Click on the timeline in your Project Timeline
window tab, and then note the Properties window Name:

Description:

to the right (if it doesn’t appear, go to the Window
menu and choose Properties to show it. You
need to check/set:

End Action: @

Override:

Menu Remote: &

End Action: What happens when the timeline
ends? You can choose to loop, go to a menu,
play another timeline, or do something else.

Color Set: | Timeline Default
Operations: All Permitted

Aspect Ratio:

Menu Remote: While watching this timeline, if E”':':'sf'j:j‘f
the user pushes “Menu” on the remote control, et
you can specify what happens.

Subtitle Tracks: 0

You can explore other options as well, but if either
of these are not set, Encore will not let you burn the disc.

A similar set of options exists for the project/disc = Properties *
itself. If you go back to the project window and

click on the Build tab, this Properties window will Name:
change and show you the properties of what will P

be the actual playable disc. Check/set:
Name: This will be the name of the disc.

First Play: When the disc is inserted in a

player, what will play first? You can specify a First Play: @
menu, a timeline, or something else. LTI e

Title Button: @i
Title Button: While playing any part of the Main Timeline
disc, if the user pushes “Title” on the remote et Audia: BTG
control, you can specify what happens. Set Subtitle: [io Change

Operations: All Permitted

You can explore other options as well, but if either
of these are not set, Encore will not let you burn the disc. You can change and verify all
of these settings at any point before you burn your disc.
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You may want to add menus, submenus, other media, and customize a lot of features of
your disc. It'll take some time, practice and poking around in the program to learn how
to do this and get comfortable with everything.

When you are ready to burn your project to a playable disc, re-verify all the previously
checked settings and options, including the type of disc that you are going to create.
Then, go to the File menu and choose Check Project... and click Start. This will
examine all parts of your project to make sure that links are properly set, all timeline

8 functions and disc functions
are set, and the user won't
encounter any operational
: : - e Capaciy problems when playing your
ne Bitrate Too High ¥ Chapters and Trims v Subtitle Text Overflow disc. If you are not sure
what a reported problem
NaLmJEE:IemDSeq...I::_Final_Eilu—ra'-,' ?EIZIpEIZI- :;;t::tr:-:nn Not Set means’ CheCk the Help

menus and documentation

for the software.

¥ Subtitle Gaps

1 items found.

Make changes to your project and continue to run the Check Project... tool until no
problems are found. Then you can go to File and choose Build... Disc... You have
one last chance to verify settings. Load a blank disc in the recorder you will use and
make sure it appears and is selected in the Destination section. Then click Build to
begin the build and burning process. Depending on the size of your project and type of
disc, this will take some time.

When the build and burn are complete, the completed disc should self-eject — if not, you
will be notified that the disc was or was not able to burn completely with a message on
the screen. Consult Help menus and other resources to determine the appropriate
solution to your problem.

As previously stated, there are many options and features of Adobe Encore that you will
want to explore, but this instruction set should be sufficient enough to get you burning a
simple playable disc.
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BACKING UP ALL YOUR WORK

Hard drives crash. Files are corrupted. People make mistakes. Your project and its
associated media could be lost at any time.

We do our best to maintain the systems and keep them in a healthy status, but every
once in a while something bad can happen. In that event, it's good to have a backup
copy of your project. YOU and YOU ALONE are responsible for backing up your
projects, media, and supporting files, and though it takes some time and should be done
frequently, it is highly recommended.

Before you back up anything, SAVE your project and QUIT the Avid software.
THE PROJECT FILE

Your project file, actually a folder containing several files, contains all of the information
for your project — bins, clip information (names, time codes, ins and outs), sequence
data, etc. Think of this as the blueprints for your work. If the project file is lost, you
cannot put things back together exactly the way they were. The project file is relatively
small in size, so it is easy to back up and even save multiple back up versions.

All project files saved to the Shared location within Avid actually save to:
Macintosh HD - Users - Shared = AvidMediaComposer - Shared Avid Projects

Browse to this folder location and copy the entire folder that is named the same as your
project, and paste it into the backup location of your choice. You may want to consider
keeping multiple versions of your project file (folder) on your personal hard drive. An
easy way to do this is to create a folder on your hard drive called “My Avid Project”, then
a separate subfolder for each version — you could use a naming convention that
expresses the date/time a version was saved, or use a version number.

That's it! Every time you make major changes to your project, it's a good idea to make
a backup. You can keep as many backups as you’d like, or have room to save. Make it
part of your editing procedure to save a backup copy of your project on a regular basis.

SOURCES & OTHER FILES

You should already have a backup copy of all of your raw footage source files from SD
or CF cards, backed up on your backup drive. But it's also a good idea to keep a
backup copy of all your other sources and related files in their original formats, such as
audio files (WAV, MP3), graphics and images (PSD, PNG, JPG), scripts, transcriptions,
logs, or any other non-media files that you need for your project (DVD project files,
compressed file versions). Where you store these files is entirely up to you, but the
point is that you should keep them all while engaged in active post-production. If you
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can use a file and folder structure identical to the one used on your primary editing
drive, you will be able to reconnect to these files much faster in the event that your
primary editing drive fails. As long as the files exist somewhere, you can get them
reloaded into your project.

IMPORTED / RENDERED / TRANSCODED MXF MEDIA FILES

If the project file is the blueprint for your work, then the media files are the bricks and
mortar. They can exist without blueprints but are better suited with them. Your media
files are the actual audio and video files you have imported, transcoded, captured,
created, and rendered within your Avid project and exist as native MXF files within the
Avid MediaFiles folder.

If the media files are lost, but you have all of the information in the project file that
indicated where they came from (tapes, other source files, etc.), it is relatively simple to
restore them through a process known as Relinking (AMA), Batch Importing (source
files), and Batch Capturing (tape). There is plenty of documentation through the Avid
help menus to walk you through these processes.

If you have imported media from numerous sources, or transcoded a lot of media after
AMA linking, you may consider backing up all of your media files to an external location.
Depending on the amount of media, this process can take a long time and take up a lot
of space.

» IMPORTANT! Check the format type of your backup hard drive before
proceeding. Drives formatted with FAT32 have a 4 GB file size limitation. If
any of your individual media files exceed 4 GB, the copy process will fail.
See the previous guide section on Hard Drives and Operating Systems.

To back up your Avid-native MXF media files, first make absolutely certain that the Avid
program is NOT running. Next, connect your personal backup drive to the system and
create a folder in which to save the backup media. DO NOT name it Avid MediaFiles,
otherwise Avid will attempt to use it as a media creation/save folder. Instead, call it
something like Avid MediaFilesBackup. Next, copy all of the files from the Avid
MediaFiles folder on your main editing drive to this new backup folder on your backup
drive. Depending on how many files you have, the size of files, and the type of
connection (USB, FW, TB) this will take some time.

If you only want to copy the files specific to a certain project, you will need to use the
Avid Media Tool to sift out the files pertaining to a certain project. Search the online
resources and help menus for information about using the Media Tool, or make an
appointment with the TV Production Coordinator to help you with this advanced-level
process.
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SYSTEM AUTO-LOCK

If you do not touch the mouse or keyboard for a period of 20 minutes, the computer
system will auto-lock and the screen saver will come on. You must strike any key on
the keyboard to disable the screen saver (moving the mouse will have no effect). Then
you will be prompted to enter your password to unlock the system.

In the event that a user leaves the system and forgets to log out, another user can log
in. However, the previously logged in user will stay logged in with all processes
running. This can cause system instability so it is bad practice to leave a system
without logging out. Only a system administrator can force a computer restart or
shutdown if another user is still logged in.

ENDING YOUR COMPUTER SYSTEM SESSION

When you’re all finished, close any open programs. Make sure that none of your
personal files exist on the desktop of the computer (if they do, move them to your own
hard drive). Empty the Trash. Then, eject and power-off/disconnect your personal hard
drives, USB thumb drives, CD/DVD discs, or any other devices connected to the
computer. Log Out of your account on the computer (do not shut down) and leave the
workstation area clean and tidy.
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IF YOU NEED POST-PRODUCTION HELP

There are a variety of ways to get help with Avid Media Composer and other post-
production software applications. Please be advised that while the Rowan Avid
systems are currently running version 8 of the software, videos featuring version 7 or
even 6 are still relevant. Version 8 is a new release that remains functionally similar to
these previous versions, with only major changes to licensing options and advanced
AMA capabilities.

e Use Lynda.com to view tutorial videos — login with your Rowan username and
password at http://www.rowan.edu/lynda and search for Avid Media Composer.
It is strongly recommended that anyone new to Avid software watch the
Lynda.com tutorial called “Avid Media Composer 7 Essential Training” by Ashley
Kennedy.

e Avid hosts a blog called “Getting Started Fast with Avid Media Composer 7” that
contains several tutorial videos. View everything at
http://www.avidblogs.com/mc7fast/, hosted by award-winning Avid editor Kevin
P. McAuliffe, for free! He even has a series of videos for Apple Final Cut Pro
editors making the transition to Avid Media Composer.

e Go online to the Avid Community User Forums for Mac users at
http://community.avid.com/forums/48.aspx. Pinned at the top of the discussions
list under Announcements and FAQs should be a posted titled “Tutorials and
Guides.” This links to lists of user videos and tutorials that will walk you through
hundreds of Avid features and capabilities. While they may indicate a previous
version of the Avid software, most are still applicable to the current version.

e Go to the “Help” menu within Avid Media Composer and keyword search for what
you want to find, or browse topics.

e Ask a classmate or person at a computer in the lab with you. They may have
already found the solution to your question, as they’re learning too!

e Ask your class lab assistant or Professor.*
e Ask the TV Production Coordinator or Engineer.”

*If the question is deemed basic or answerable via watching tutorials, reading this
guide, or searching a help menu, these people will refer you to those methods for
solving your problem. Learning the Avid software is a process — you can’t do it
overnight and your instructors can't tell you everything. By doing a little research you
might find out more than you needed to know, but it will help you more than you think!
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ROWAN UNIVERSITY
COLLEGE OF COMMUNICATION & CREATIVE ARTS

TV POST-PRODUCTION GUIDE - NOTES
September 2014 Edition

Written and Prepared by
Christopher J. Winkler, TV Production Coordinator

This guide features instruction based on the following software and hardware:

Avid Media Composer 8.0.1, Adobe Creative Suite 6 / Creative Cloud 2014 Edition installed on a 27” iMac

running OSX 10.9.4 (Rowan-configured image), Intel Core i7 3.40GHz and 8 GB RAM.

Changes appearing in this edition, since 2012R1:

New cover art.

Table of Contents: Fixed page numbering inconsistencies due to page wrap in printing non-PDF
versions of the document. All released and hard copy versions are now PDF.

Hard Drives & Operating Systems - now includes considerations for exFAT formatting.

Media Technical Formats - now includes considerations for GoPro Hero 3+ Silver HD cameras.
All information re-written and screenshots updated, specific to Macintosh computers
(specifications above) adhering to Rowan computer network security policies, implemented in all
labs in summer 2014. This includes updates pertaining to system login credentials, timeouts, and
network server access procedures. Materials pertaining to Windows PC-specific programs and
procedures have been removed, except for areas involving videotape and related procedures.
iMacs in Lab 154 do not have external hard drives. Students can use a designated folder on the
Macintosh HD to save their files outside of Avid, if they do not have their own external hard drive
at the beginning of the semester, or for lab exercises. The path is Macintosh HD > Users >
Shared 2> RTFUSERSHARE.

Added information that explains how to find and access card-content media files within the
“private” card folder when OSX disguises subfolders folders as playable QuickTime media files.
The Shared save location for Avid projects is now recommended over Private due to likely
changes in user Documents folders on the Rowan network, which would cause the Private
location to save to a user’s networked H drive folder. It is highly problematic to edit a project file
saved on a network volume. The Shared save location will remain on the local computer.

There is no format restriction due to system technical capabilities. Previously, PC systems could
not handle 1920x1080 footage in long format projects. 720/60p is still the format being
recommended and used for examples in this guide, but it is not required. Users will have no
problem using other standard NTSC/ATSC formats.

Avid transcoding now offers an option to transcode only AMA linked media within a sequence;
previously, choosing to transcode a sequence forced all media to be (re-)transcoded whether it
was AMA or not.

Transcoding can now be done as a background service with status monitoring (this is different
from background rendering, which is still not available in Avid software). However recent testing
on Rowan systems was intermittent in the ability of the system to successfully complete the
transcoding for all files in the queue. Non-background (normal) transcoding of the same files
completed 100% of the time, without errors. As a result, it is being recommended that
background transcoding NOT be selected at this time.
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e Added a section that explains batch importing, which is preferred over re-importing materials
changed outside the Avid application.

e Added a section introducing the basics of the Title Tool application.

e Sorenson Squeeze licensing was outdated and the program could not be installed on iMacs with
the current operating system. Adobe Media Encoder CS6 / CC has replaced Squeeze as the
compression software for system users, and all reference to Sorenson Squeeze has been
removed.

¢ MPEG2 DVD and MPEG2 HD BR encoding formats are not currently installed on the lab
machines for use with Adobe Media Encoder. When this is resolved, the sections of the guide
explaining these compression settings will be updated with a mid-semester version update.

¢ Adobe Encore is not installed for DVD or BR burning on the lab machines. When this is resolved,
the sections of the guide explaining this software will be updated with a mid-semester version
update.

e Added information about system and account auto-lock feature requiring user password entry
after 20 minutes of inactivity.

o Updated and added new links to online Avid tutorial videos.
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